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for reading this far, and we hope that the rest of the
magazine is more interesting than this.

• • •

Thanks for reading atpm.
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Welcome
Robert Paul Leitao, rleitao@atpm.com

Welcome to the February issue of About This Par-
ticular Macintosh! This month, Punxsutawney Phil
pokes his head out of the ground, and the world waits
to hear if he sees his shadow. This issue, our editors
poke their heads into the world of Macintosh comput-
ing to keep our readers out of the shadows and shed
light on the many recent announcements that impact
what we call the “personal computing experience.”

What’s In a Name?
At January’s Macworld Expo, Apple CEO Steve Jobs
announced that the Mac maker has undergone a name
change. In brief, the company’s name was shortened
from Apple Computer to Apple. The name change
reflects the company’s success in markets outside of
the personal computer industry such as digital music
players and entertainment content distribution. It
was also a nod or recognition toward the company’s
yet-to-be-released iPhone.

The iPhone brings with it another naming issue.
Cisco Systems claims the rights in the US to the
iPhone product name. Apple has virtually undis-
puted rights to the name outside the United States.
Cisco makes claim to the name through acquisition.
Apple makes claim to the name through approbation
and appropriation. Approbation due to the iPod’s
popularity and consumer expectations for Apple to
deliver successful “i” prefixed products. It’s appro-
bation because that’s the name Apple wants to use
for its cell phone product. Cisco and Apple are now
legally jousting over the name, and a court may have
to decide if public approbation in this instance is ap-
propriate for appropriation. Perhaps adding Apple’s
shortened name as a prefix to its popular product
prefix will resolve the issue.

Billion Dollar Baby
For the first fiscal quarter ended in December, Apple
delivered to its shareholders a whopping billion dollar
quarterly profit, setting a quarterly earnings record
and moving the double-zero currency suffix one more
digit to the right. Achieving a ten-digit quarterly net
profit grabbed headlines but couldn’t pull the com-
pany’s share price to higher ground.

Buy On Rumor, Sell On Fact
The fact is Apple earned $1.0 billion dollars in the De-
cember quarter on revenue of $7.1 billion. The sale of
22 million iPods, a favorable income tax rate of about
32%, and average gross margins of 31.2% on products
sold helped the results. During the quarterly period
the company also sold 1.606 million Macintosh com-
puters. Apple ended the quarter with a pick-up of
$1.75 billion in cash, raising the height of the com-
pany’s cash pile reach $11.9 billion.

Rumors of an Apple iPhone became fact at the
January expo, sending Apple’s share price to an all-
time high in the days before the earnings release of
$97.80 in regular trading. Although the results set
company records, Apple management chose to pro-
vide guidance for the current fiscal quarter based on
shipping products (the iPhone won’t debut until later
this year), sending the share price plummeting to its
pre-expo trading range of $85 per share. AAPL ended
January trading in New York at $85.73 per share. Eu-
phoria that the iPhone rumor is now a future product
reality wasn’t enough to keep the share price climb-
ing once the results for the December quarter became
fact.

Shuffling Colors
No matter Apple’s quarterly results were decidedly
only one dense color (bold and black), the company
decided to change the diminutive iPod shuffle away
from its previously uniform shade of gray. The shuffle
now comes in an assortment of five colors ranging
from the original gray to pink. We’ll see if the new
Shuffles add a spectrum of success to this quarter’s
results.

Accentuate the Positive
Most everyone who surfs the Web or watches TV in
the US has seen Apple’s TV commercials personifying
the Mac and the PC. Recently, Apple released similar
commercials in Britain with different actors accentu-
ating the benefits of the Mac. The actors come com-
plete with British accents of their own and a slight
change to the dialogue designed for the British mar-
ket. Europe was a bright spot for Mac sales in the
December quarter.
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Apple TV
Apple’s much-anticipated wireless set-top box is now
shipping to consumers. Reports indicate the first
manufacturing run of 100,000 units has already been
sold, and the company could sell 1 million or more
Apple TV units this year. Priced at $299, this Mac
or PC peripheral may change the way we buy, store,
and enjoy entertainment content.

Our February Issue
We’re happy to say our February issue is also a ship-
ping product. Each page of news, views, and reviews
is designed with you, our readers in mind. No doubt
our managing editor is busy unwrapping his new Ap-
ple TV in time to screen his home brew movies for
families and friends before the Super Bowl. By next
month, I’m sure he’ll figure out a way for you to read
our publication in Apple TV widescreen format. But
please, screen it from a Mac.

Our February issue includes:

Bloggable: Holy Cow!
Several months ago, Wes Meltzer offered to eat his
hat if he was wrong about the non-existence of the
iPhone. At Macworld Expo San Francisco, Steve
Jobs offered him a fork and knife. It exists, and
the sheer “wow” factor made it the only topic of dis-
cussion in January. That, and much more, in this
month’s Bloggable.

Mac About Town: “A rose by any other
name. . .”
Phones, TV interface devices, a name change. . .there
are changes afoot, friends, and the question is, “When
can I get my iPhone?” I mean, what does the future
hold for those of us who are Mac users before we are
iPod or iPhone or Apple TV users?

Apple Talk: Safari
Apple Computer is dead. Long live Apple, Inc.

Next Actions: A Survey of the GTD App
Landscape
Newcomer Ed Eubanks, Jr. covers a mega-
smorgasboard of GTD (Getting Things Done)
applications.

Photoshop For the Curious: An Overview,
Part 3
In the third and final part of this overview explor-
ing the Photoshop interface, we’ll peek into Photo-

shop’s menu bar. This month also features Lee’s first
tutorial—creating better black and white photos.

How To: Demystifying the Uninterruptible
Power Supply (UPS)
“Contrary to my normal routine of research first, I
went down to one of the local big box retailers to
browse the UPS selection—after all, how complex
could it be, right?”

Desktop Pictures: Little Leaf Sea
Reader David Kettlewell shares photos from the
sunny, frosty forests of northern Sweden.

Cartoon: Cortland
Cortland has junior-high flashbacks after a night of
swing dancing with Angie doesn’t go like he planned.
Meanwhile, the chameleonesque Agent Smith arrives
in town, palming a familiar-looking comm device. . .

Review: Arctic Quest 1.0
Arctic Quest for Mac is a Tetris-like game that is
pretty, but I’d rather just play Tetris.

Review: MoRU 1.3.4
Spotlight is nice but has a habit of displaying a
haystack of results taken from a larger haystack.
David B. Thompson takes a look at a utility that
refines Spotlight searches and reduces the number of
returned hits.

Review: NetworkLocation 1.1
NetworkLocation attempts to restore the classic Mac
mentality of a location as a place and not just a net-
work connection.

Review: Python XL System
Continuing atpm’s frequent review of bag products,
this month, Frank H. Wu looks at Booq’s Python XL
System.

Review: SWF Movie Player 2.0
Watch, save, and interact with Flash files—without
Flash restrictions. SWF Movie Player brings user-
friendly playback to Adobe’s Flash.
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E-Mail
Audio Hĳack Pro 2.71

Too bad that you just hit below the hardware thresh-
old for recording on Audio Hĳack Pro. If your hard-
ware is only two generations old instead of three,
there’s no downside. I have a 1 GHz iBook G4 that
it records just fine with. And it should be just fine
on any hardware sold in the last three years, if you
have enough RAM.

Audio Hĳack doesn’t do MP3s but iTunes does.
It’s very easy to record to AIFF, drop the file into
iTunes, and select Convert to MP3 in the Advanced
menu. (If you’re running Tiger you can even create
an Automator action for this.) Discard the AIFF to
save space. It may be just a bit awkward, but it works
for budget recording. I did that for a year before I
finally ponied up the upgrade fee for the Pro edition.

Before they podcasted Science Friday, I grabbed
the show every week. I still use it for New Dimensions
online broadcasts, which happen at 10 PM Sunday
night in Seattle. I listen to a lot of podcasts or time-
shifted Internet broadcasts during my commute.

I’m glad I upgraded, though. There’s a lot of
functionality in Audio Hĳack Pro for not a lot of cost.
I’ve recorded with it too, both my own podcasts and
presentations for our local MUG, though I normally
use GarageBand for that.

—Michael

• • •

I’ve been using Audio Hĳack Pro for about a year now
to record my favorite radio shows—Car Talk, Thistle
and Shamrock, Hearts of Space, etc.—and I’ve found
it to be relatively trouble free. I am currently running
a shiny new 20′′ Intel iMac, but I was running a 1
GHz iMac G4 previously without problem. The only
glitch I have with the new iMac is that it doesn’t
automatically drop my recordings into iTunes unless
iTunes is already open.

—Larry Snyder

• • •

I have used Audio Hĳack Pro for recording vinyl on
my 700 MHz iBook G3. No problems with skipping
at all; the only trouble I had was with the auto-split

1http://www.atpm.com/13.01/audio-hijack.shtml

on silence function. There’s too much noise on my
old records for it to function properly, and this can
hardly be blamed to Audio Hĳack Pro. I think it is
a very good piece of software.

—Ronald Lamars

iTalk Pro2

I found your article helpful. I also find it problem-
atic that iTalk Pro reverts to automatic every time it
is unplugged. I also find the fluctuations in level in
automatic mode a major problem for music record-
ing. In addition I get a “clipping” sound in auto-
matic mode that makes the recordings useless. In
high mode I get a lot of distortion, but in low mode
it seems OK. I’m using a Sony ECM-MS907 stereo
mic with the iTalk Pro and an 80 GB iPod video.
The Sony mic worked well with my MD recorder.
I am wondering where I can find specs to match a
mic with the recording capability of the iPod and the
iTalk Pro. The mic I am using now does not seem
to be a good match, or is it the iTalk Pro that is
the culprit? I’m considering trying the Belkin or Ex-
tremeMac product. Do you have any ideas for match-
ing a mic for music recording with the iTalk Pro or
the other devices?

—Peter McEachern
Using an external mic is tricky, but not impos-
sible. The thing to remember about the jack
on the bottom of the iTalk Pro is that it’s a
line-level input. Microphones are generally a
mic-level input, which are much lower voltage
than line level. If you visit an audio shop that
carries such mics, you can tell them you have a
device with a 3.5mm stereo line-level input and
you’re wishing to check out microphones that
can plug into this, and see what they offer.

—Lee Bennett
The basic issue here is whether the micro-

phone outputs a high voltage level or low volt-
age level. Many, though certainly not all, mics
with 3.5 mm jacks are high output, appropriate
for use into a line level input such as the iTalk
Pro’s. Microphones with 1/4′′ phono or XLR
style connectors are almost always mic-level and
require a mic-preamp to boost the signal to line
level. They may also require “phantom” power
which provides a power source for the mic along
the actual audio cable. This is why you should

2http://www.atpm.com/13.01/italk-pro.shtml
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not just slap an adapter on the end of a mic
with the wrong size connector, and then plug
it into the iTalk. Nothing bad will happen, but
you will not get enough gain, and the resulting
recording will be inaudible. My advice if you
are unclear on all of this is to call up a place
like Sweetwater Sound or a similar supplier and
ask them for help.

—Evan Trent

Photoshop For the Curious3

I just stumbled across this article (via the first one4)
looking for Photoshop related items.

Not knowing a thing about Photoshop, and just
sort of teaching myself by stumbling around the but-
tons a bit, was probably not the best idea!

But thanks for these articles—I’ll be back to check
if there are any more in the future.

It’s much appreciated, at least by me.
—Fran

Glad you liked what you saw. Presently, this
series is planned as a monthly series with no
specific end. . .just as long as I can keep coming
up with topics to cover, and I have plenty to
keep it going for at least this year. Feel free to
hit the subscribe5 link for notifications of each
monthly issue, or to have the issue delivered as
an e-mail attachment. You can also use the
RSS feed6 for new issue notifications.

—Lee Bennett

Outliner Writing Environments7

I’m discovering your new word processing review
project late, the first day of 2007, but I want to ex-
press my appreciation for the project: much needed
for someone to go into the matter with the degree of
thoroughness (and length) that you have brought to
outliners.

Like many others I’ve bought perhaps dozens
of outliner/information manager applications, and
(since they tend to be more expensive) maybe a score
of word processor apps, all looking for that perfect
one for me. Sadly, I came closest in that search with
things that died with OS 9 or even earlier. Some of
these had terrific features I haven’t seen since.

3http://www.atpm.com/13.01/photoshop.shtml
4http://www.atpm.com/12.12/photoshop.shtml
5http://www.atpm.com/subscribe/
6http://www.atpm.com/rss/index.shtml
7http://www.atpm.com/12.11/atpo.shtml

Since your coverage has included some apps
that aren’t mainly outliners but rather information-
managers, I will mention briefly some oldies that
haven’t been equalled: MailKeeper (from Nisus, OS
9 and before) a simple snippet- or article-keeper with
a unique progressive multi-factor search/winnowing
feature that was very fast, enabled instantaneous
reviewing of information pieces or articles; Papyrus—
the old bibliographic reference application, not the
current office suite—which had a marvelous sys-
tem of hierarchical, combinable keywords; three by
five, an outliner with several interfaces including a
corkboard like the new application Scrivener; and
ThoughtPattern, another snippet-keeper which used
a good keyword system.

With word processors, I would be very happy to
have the advanced features found in the ancient Full-
Write or WriteNow. They had more than one kind
of marginal notes, outlining, footnotes—before Mi-
crosoft Word had such things—and since the demise
of these old programs it has taken a very long time
for marginalia, footnotes, and outlining to return to
independent Mac word processors.

I used the old Nisus Writer until OS X; nothing
has compared to it since then, in my opinion, though
the most recent version of Nisus Express is doing very
well. But will we ever see again features like Nisus’s
“Document as Graphic,” which allowed you to insert,
as a scalable graphic link, a picture of any page of
another document—it could appear big enough to be
read, and clicking on it opened the original, so it was
better than just having a link to another document,
and was a big help in reviewing various articles or
pieces of writing, putting them all in one place for
your consideration.

After Nisus, I used the Japanese word processor
Jedit8, which has “bookmarks” (like the old Nisus
Writer’s Markers) links that can be viewed in a sep-
arate window, making a Table of Contents or a list
of-places to check, or high points, whatever; a Search
All that shows all the instances found together in a
window as clickable links, each with part of the sen-
tence where it appears—in one document or many;
rectangular and multi-selection; clean effective inter-
face; the “remember an added tab for subsequent new
lines” feature that Nisus Writer used to have”; a help
doc in Jedit format, using the sidebar outline/table
of contents feature, so you can get help without wait-
ing for Apple Help, or Preview, to open; multiple

8http://www.artman21.net/product/JeditX/index_E.htm
l
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“Find & Select”—found items are selected as multi-
ple discontinuous ranges at once; all in all it is pretty
good for me, lacking only a few important features
like marginalia and footnotes.

So, I do think you should include Jedit and Nisus
Express in your survey, and (dark horse!) you might
also look at the editor in CopyPaste. I think few no-
tice that it even has one, they just use the multiple
clipboards. It hides its light under a bushel, being
called merely the “Clip Editor.” In CopyPaste, se-
lect “CopyPaste X Help” from the Dock menu or the
CopyPaste menu, and you will get Help in the form of
a complex document in Clip Editor that will demon-
strate its capabilities; of the features I look for, it
has a sidebar “Navigation frame”/file browser which
shows sections and paragraphs; discontinuous multi-
selection; accepts graphics and media files; an ad-
vanced find that can search for sound-alikes, regard or
disregard diacritical marks, and other keen things and
also search multiple files, view all results, even collect
each paragraph containing the search term from ev-
ery document searched into one document, making a
compilation for you (a feature the old Nisus Writer
had in an even more advanced form).

I am eager to see the new series, and thanks for the
advance listing of programs, because I found at least
one there I had not seen before that looks interesting.

—Cynthia Cheney

Coping With Mac OS X’s Font Rendering9

Just bought my first Mac, a MacBook. Have spent
whole morning on support trying to explain that the
letters are blurry, to no avail.

By the time the highest resolution is on, I can’t
read anything in 12pt.

Also, it is all fuzzy. Thanks for helping me not
feel like it’s just my 40-something eyes or that I’m
losing it.

—Rebecca S.

• • •

I have to say that I’m switching to Ubuntu Linux
simply because (and only because) its font rendering
is far superior. On a decent LCD, it’s almost as good
as reading a printed page.

—Y M

• • •
9http://www.atpm.com/12.01/paradigm.shtml

I’m a new Mac OS X user and, like others here, I’ve
been struggling with the fonts. Sometimes I feel like
I’m going blind looking at the thing. I did find a set-
ting in my LCD that does make a difference. Not all
monitors have this control so your mileage may vary.
The control is called “phase,” and tweaking it has
gone a long way to sharpening the smaller fonts. In
all, however, I’m pretty disappointed with font ren-
dering in this OS. Fonts on my XP notebook are so
sharp they’re almost difficult to look at after “adjust-
ing” to OS X.

—Eric H

• • •

I, too, am having real problems with OS X and font
anti-aliasing.

I really notice it when I use the same program, on
the same screen and at the same time, in XP and in
OS X. I do this in Parallels on a MacBook, with the
left half of the screen for OS X and the right for XP.

Using the browser Opera on both OS X and XP,
text in OS X is almost illegible (especially e’s). On
XP with ClearType it is beautiful.

I find the same thing with Word documents.
What gives, Apple? The font smoothing is OS
X is absolutely terrible. Almost everything looks
smudged. How can Apple have gotten it so wrong?

—Alex Hamilton

We’d love to hear your thoughts about our publication. We
always welcome your comments, criticisms, suggestions, and
praise. Or, if you have an opinion or announcement about
the Macintosh platform in general, that’s OK too. Send your
e-mail to editor@atpm.com. All mail becomes the property
of atpm.
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Bloggable
by Wes Meltzer, wmeltzer@atpm.com

Holy Cow!
It’s here.

That’s right, ladies and gentlemen: at Macworld
Expo San Francisco, Steve Jobs stood before the au-
dience and introduced the iPhone. But you probably
already knew that. So I have something to apologize
for: I’m sorry I doubted you, Steve, and if my hubris
in all but guaranteeing1 there would be no such de-
vice is what drove you to release it, I am doubly sorry.

I have actually taken up a fork and knife and have
pierced my hat2 in recognition.

Before you get giddy about the prospect of watch-
ing me eat my grimy white Northwestern baseball
cap, let me just note that I am not going to video-
tape it. You’re going to have to take my word that I
sampled the taste of it, though I could not actually
digest it and so I stopped after just a little bit.

The most tragic part is that I was prepared to
write a column about MacHeist and MacZot, and
then Jobs had to ruin my plan at MWSF. Thanks for
nothing, Apple! I’m not even a Cingular customer!

If you somehow missed the announcement itself,
or you want to read a little more useful informa-
tion than the admittedly nifty demos on Apple’s
Web site, you should probably start with Time’s
primer on the iPhone3 and move to Paul Boutin’s
awfully good Slate article about the device4. These
are highly general articles, and can get you up to
speed for the rest of this column.

I’ll wait here.
Oh, you’re back already? Well, hello again!
David Pogue, writing in the New York Times,

had an excellent two-part FAQ he calls the “Ultimate
iPhone Frequently Asked Questions,” parts one5 and
two6. So far, I have yet to see anyone ask a ques-
tion that David Pogue hasn’t answered, other than,

1http://www.atpm.com/11.01/bloggable.shtml
2http://www.atpm.com/12.10/bloggable.shtml#and-not

hing-left-to-bur
3http://www.time.com/time/business/article/0,8599,1

575743,00.html
4http://www.slate.com/id/2157400/fr/rss/
5http://pogue.blogs.nytimes.com/2007/01/11/the-ulti

mate-iphone-frequently-asked-questions/
6http://pogue.blogs.nytimes.com/2007/01/13/ultimate

-iphone-faqs-list-part-2/

maybe, “Can the iPhone help keep my parents from
sleeping on my futon couch for two weeks whenever
they come to town?” (I think the answer is yes.)

And now a moment of irreverence before we get to
the serious analysis, from the Macalope7. Actually,
it’s pretty good analysis too, one of the reasons I
always enjoy it/him.

Now, moving along. Our first stop is Bruce “Tog”
Tognazzini’s column, Ask Tog, in which he takes a
look at the iPhone and concludes (surprisingly) that
it’s pretty impressive8:

iPhone is revolutionary, not a big surprise
coming from Steve Jobs. He knows how
to gather a tiny team of brilliant young
minds and work them half to death un-
til they innovate beyond any reasonable
expectations. He has the common sense
to know what will ultimately find favor.
And he has the hardened-steel man parts
to take a chance and roll with it. What’s
a pity is that so few others in this industry
share those triple strengths.
[. . .]
I could go down through the other “in-
novations” in iPhone and slowly knock
them off. Yes, it’s the first cell phone
with a visual display of voice-mail mes-
sages, so you can randomly move among
voice-mails, etc., etc. However, such lists
have been displayed, in an identical fash-
ion, on enterprise-level voice-mail systems
and, of course, such lists have been a stan-
dard feature in e-mail for decades.
The origins of these bits and pieces, how-
ever, is not what’s important about the
iPhone. What’s important is that, for the
first time, so many great ideas and pro-
cesses have been assembled in one device,
iterated until they squeak, and made ac-
cessible to normal human beings. That’s

7http://www.macalope.com/?p=140
8http://www.asktog.com/columns/070iPhoneFirstLook.h

tml
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the genius of Steve Jobs; that’s the genius
of Apple.

And Khoi Vinh, who is a serious design guru,
seems very impressed by the fusion that Ap-
ple provides by putting the software in a box
they control. It’s an advantage, he says, that
Palm had and squandered9. As the owner of a
Windows Mobile Smartphone, which is Microsoft
software in an HTC device, I can throw in my two
bits here and say that he who controls the hardware
and the software, on a closed platform, can provide
a vastly better user experience. Vinh says:

In Jobs’ presentation, he repeated Alan
Kay’s advice that those who are serious
about software should make their own
hardware. Apple has benefitted from this
wisdom for years, stubbornly remaining
in the hardware business even as the mar-
ket has, until recently, consistently urged
the company to focus only on software.
Few technology companies can claim to
make “the whole widget,” and Palm, like
Apple, is one of those lucky few. Given
their early lead in the portable devices
market, Palm should have been able to
parlay their hardware and software ad-
vantage into a truly innovative device long
before now. Instead, they’ve been caught
apparently sleeping by this iPhone, and
Apple looks set to eat their lunch. Shares
in the company were down almost six per-
cent yesterday.

The real question, though, is, what will the rest
of the industry do? If history (viz., the iPod) is any
guide, they will completely misinterpret the success
of the iPhone and start churning out look-alike de-
vices while adding a thousand features. Sometimes,
less really is more10, as Thomas Fitzgerald notes:

The electronics industry is obsessed with
features, while Apple is accused of form
over function, but Apple’s supposedly
“form over function” iPod has been a
huge success. When the iPod was first
released there were other MP3 players

9http://www.subtraction.com/archives/2007/0110_bad_
for_palm.php

10http://www.thomas-fitzgerald.net/2007/01/17/reacti
on-to-the-iphone-reveals-how-the-electronics-indus
try-failed-to-beat-the-ipod/

on the market. None were the size of
the iPod or as easy to use, but manu-
facturers didn’t think it would matter to
consumers because the iPod was more ex-
pensive than their players, which offered
pretty much the same basic functionality.
I think part of the problem too, was that
many early MP3 player manufacturers
saw their products as computer acces-
sories rather than an “appliance” type
of pure consumer electronics product. It
never seemed to occur to anyone other
than Apple that the “user experience”
was an important issue; after all if you
could use a computer you could use an
MP3 player. So why didn’t anyone learn
that lesson before it was too late? I
believe it is because companies are so set
in their ways that they simply failed to
grasp the simple truth of why the iPod
has been a runaway hit. The answer
lies in a nursery rhyme that is taught to
children the world over. “It’s not what
you do, it’s the way that you do it.”

And then, there’s the really radical commentary.
Dan Benjamin believes that, like the last paradigm-
shattering Apple product, the Macintosh, Apple
has removed the user-device interface limitations
that have been holding back cell phones11 with the
iPhone’s UI:

Just like a calculator, their capabilities
and limitations are determined by the way
we’re forced to interact with them.
Apple has removed that limitation, tossed
out the keypad and replaced it with some-
thing that can change on the fly, based
on the task you want it to perform at
any given moment. It makes for a device
that’s very cool and seems to have its own
reality distortion field just like its creator.
People seem spellbound by it.
[. . .]
Is the flexibility of this new type of inter-
face worth giving up [the] muscle memory
[of keys] for? Only time will tell, but I’ll
bet the answer is yes.

11http://hivelogic.com/narrative/articles/regarding-
the-iphone
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Last but not least, Andy Ihnatko of the Chicago
Sun-Times actually got his hands on an iPhone, and
spent “about 45 minutes noodling around with the
device.” First of all: how is this fair? Am I not as
important a Macintosh pundit as he is? (No com-
ments from the peanut gallery.)

Second: damn.
Third: he seems awfully impressed by the phone,

in general, including the soft keyboard, which is one
of the things holding a lot of people back for the time
being. He says that the keys are larger than Treo
keys, because they’re not limited by microscopic
physical space, and this leads to a vastly better
experience. Among other things12, like a “beautiful
freakin’ display,” and the usual impressive attention
to detail that Apple gave the software interface. He
says that the e-mail client, for instance, “make[s]
you feel like you’re using a powerful desktop appli-
cation, not a cell phone that can kind of send e-mail
and browse the Web (depending on how you define
‘e-mail’ and ‘the Web’).”

I’ve pooh-poohed the idea of an iPhone in the
past, but Apple seems to have genuinely nailed the
device. I think the various factors that caused me
to dismiss it in the past, like the form factor of cell
phones versus iPods, have been pretty conclusively
resolved by making the entire device touch-sensitive;
it’s more like my iPAQ than either a conventional
cell phone or iPod. And when I wrote that column,
in 2003, Apple had yet to release a flash-based iPod
at all; a 1.5-inch hard drive in a cell phone would
have been preposterous.

At the same time I am skeptical, still, as techni-
cally impressive as the iPhone seems to be. It remains
to be seen whether I’m really going to want to listen
to music on the same device as I receive calls, since
one of the selling points of using a standalone iPod
is being freed from a lot of earthly distractions. Add
to this my skepticism at fitting this into my jeans
pockets, and I may have to wait a while.

I still regret signing a two-year contract for my
current phone.

Original Sin
This column was originally supposed to be about
MacZot13 and MacHeist14, the software discount pro-
grams for Mac shareware and payware. MacZot is
a sort of discounted shareware clearinghouse, which

12http://www.suntimes.com/technology/ihnatko/215441,
CST-FIN-Andy18.article

13http://maczot.com/
14http://macheist.com/

regularly posts new software with a developer mark-
down, to get more product exposure. MacHeist was a
one-time bust, a bundle of 10 pieces of software sell-
ing for $49, which was ostensibly a sort of combined
discount program and charity give-away.

The problem is that the numbers don’t seem to
add up to benefit for developers, and some of them
started noticing it. And I can see why.

When I was in college, which feels like a long time
ago already but only ended seven months ago, I took
courses on advertising and marketing. We talked
about all of the various reasons to offer product dis-
counts, and one of them is indeed to get better expo-
sure. But, of course, I’m sometimes reminded of the
old joke about the chapelier who sells his hats at a
loss and intends to make it up in volume. Discount-
ing is a whole different ballgame when it’s physical
goods. Software’s per-unit production cost decreases
with the more copies you sell, but that makes it much
harder to set a value for it. And that’s where the
trouble lies.

Steve Harris started the fire, in November, when
he observed that he hadn’t increased his volume of
regular-priced sales on KIT, a sort of Yojimbo15-alike,
after offering a discount16 via MacZot. What he had
done is sold a lot of copies at a discount, which came
with the same user- and technical-support costs as
the regular-priced copies. That’s not necessarily a
bad thing, but it didn’t make financial sense, and it
didn’t get him the exposure he had hoped for with
MacZot: the kind of user who frequents a Macintosh
shareware-discount site is the kind of user who (a)
probably already knows about your software and (b)
is buying it at a discount because he or she knows
about it but isn’t willing to buy it at full price.

John Gruber (you knew he was coming sooner
or later) saw the comment, and he made Harris’
implication explicit. As he sees it, there’s a very
real floor on the cost of your software, and lower-
ing its cost to or below that floor doesn’t benefit
you, because all it does is cut into your margins,
without increasing your sales17 to users who are
paying full price. (See above.)

No matter what this application does, no
matter who the target audience is, there
are some potential users in that audience
who will want to use it but who will not

15http://www.atpm.com/12.06/yojimbo.shtml
16http://reinventedsoftware.com/blog/2006/11/07/disc

o-inferno/
17http://daringfireball.net/2006/11/pinprick
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want to pay for it. Most of these cheap-
skates will not come right out and tell you
this (i.e. that they don’t want to pay any-
thing for your software). If you charge
$40 per license, they will say, “This is a
great application, but it’s too expensive.
I’d buy it if it were $25.”
But if you had set the price at $25, they’d
tell you it should be $15. If you charged
$15, they’d tell you it should be $10. If
you charged $10, they’d tell you it should
be free. And on that last point, the cheap-
skates would actually be right. $10 is not
enough money to charge for professional
quality software. If you, the developer,
don’t think it’s worth ten bucks, you re-
ally should just release it as freeware. An
excellent, popular piece of freeware might
help you professionally even if it doesn’t
help you monetarily.
The point here is that you can’t set a
price low enough to please the cheap-
skates. If you can’t create software that’s
worth at least $20, you’re not going to
make it as a full-time indie developer.
And if you look at the indie Mac devel-
opers who have made it, you’ll see that
they typically charge at least $25 for their
software.

A few weeks later came MacHeist, the heavily dis-
counted bundle of software, and at that point the
floodgates simply opened up, ensnaring almost ev-
ery Mac-centric or Mac-relevant voice on the Inter-
net. (Which is why, two months later, I’m writing
about it.) A little more background was the clever
Christmas-related peg for the promotion: they would
donate 25 percent of the proceeds to charity. I laud
them for that; it turns out that they raised $200,000
for charity.

But that isn’t the whole megillah, literally. It isn’t
even the whole first verse.

Gus Mueller, who wrote the excellent VoodooPad,
notes that he was offered $5,000 to include his appli-
cation in the bundle, which is really not that many
copies of VoodooPad at full price; his objection was
that he got $5,000 whether MacHeist sold 100 copies
or 100,000 copies. That’s a raw deal18 any way you

18http://www.gusmueller.com/blog/archives/2006/12/we
ek_of_the_independent_mac_developer.html

cut it, and it meant that the MacHeist guys were
going to make out like bandits.

Gruber saw those numbers and wrote about how
he simply couldn’t believe it19:

Mueller was right to ask for a percentage
rather than a flat fee; the economics
of paying the developers a flat fee in
exchange for an unlimited number of
licenses tilt grossly in the favor of the
MacHeist team. . . [B]ecause these pay-
ments are for a flat fee, as sales goes up,
additional profits all go to the MacHeist
organizers.

He then crunched the numbers20 after the promo-
tion ended, too, and computed that MacHeist took
in $760,000, paid $66,500 to software developers, and
then ended up with its organizers pocketing a cool
$463,500. That’s 87.5 percent of the non-charity to-
tal, which would make even Drew Rosenhaus salivate
in jealousy. (Note to Rosenhaus: try this with Terrell
Owens. The ensuing fight might take you both out
of the arena. We will be grateful.)

Paul Kafasis at Rogue Amoeba saw the same
double-speak21:

It’s been argued that this can be good
for developers by providing more expo-
sure. Personally, I just can’t see that,
but maybe it’s true. Declaring this “The
Week of the Independent Mac Devel-
oper,” however, has left a sour taste in
my mouth. The people who stand to ben-
efit directly here aren’t the developers,
but the people behind MacHeist. Urging
people to buy this bundle to support the
developer is disingenuous at best.

He adds, to this, that developers are really getting
a one-two punch: they could very well undercut their
full-price sales of their product, and they are sad-
dled with ever-decreasing per-unit profits while the
MacHeist organizers make a profit that increases at
a linear rate.

That doesn’t stop Uli Kusterer, for instance,
from defending MacHeist. As he put it, maybe

19http://daringfireball.net/2006/12/iniquities_of_th
e_selfish

20http://daringfireball.net/2006/12/macheist_lousy_t
shirt

21http://www.rogueamoeba.com/utm/posts/Article/Whose
-Week-2006-12-12-12-00
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the developers really did see22 a publicity benefit.
Kusterer is still skeptical, but he’s willing to give
MacHeist-participating developers the benefit of the
doubt, something Gruber isn’t:

I think they were well aware of what they
were doing, and considered it a good deal
because they’d get what they expected
out of it. Maybe they even made a tacti-
cal decision to take some damage for fu-
ture benefits.

Not everyone was negative. Wil Shipley (to be
fair, a participant) defends MacHeist as good public-
ity for developers and all of the bloggers and media
outlets that have been gladly opining on it23—but
my grandmother would call that a compliment with
the back of your hand. (This is the usual knock on
the press, and I think it’s unfair.) Oh, and CARS
proposes that the next MacHeist promotion be
the “Week of Sweatshop Mac Developers24.” CARS
may be the Macintosh community’s very own “Daily
Show,” proving truth through comedy, but this is
also a genuine comedic gem:

VoodooPad developer Gus Mueller said
“For every dollar a developer makes on
this deal, MacHeist makes 25. Also, part
of the contract says they get to punch you
in the groin. What’s that about?”

How can I top that? Good night and good luck.

Copyright © 2007 Wes Meltzer, wmeltzer@atpm.com.

22http://www.zathras.de/angelweb/blog-john-gruber-ma
cheist-figures.htm

23http://wilshipley.com/blog/2006/12/marketing-irony
.html

24http://www.crazyapplerumors.com/?p=742
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Mac About Town
by Mike Chamberlain, mchamberlain@atpm.com

“A rose by any other name. . .”
Macworld Expo has come and gone. Did you hear
that Apple has some new “iPhone” or something?
Yeah, me too.

I have anticipated the iPhone eagerly, as I long
ago tired of my Toshiba 9950 and Palm T3 combina-
tion. Watching Steve work his magic at the keynote
was exciting, and I immediately posted my e-mail
with Cingular. I will have to change carriers—but
having no current obligation, at no cost. Now that a
few days have passed, however, the concrete details
are beginning to sink in, as are the questions.

I, for one, am unlikely to use an iPhone as a mu-
sic device apart from playing with ring tones or back-
ground hold music (features that are not yet promised
or certain). Further, I doubt that I will use the video
iPod features. I would be most likely to use video
while traveling, but that is also the time I need a
phone charged and ready to go. Others have already
noted that arriving at your destination with a low
battery warning is a real problem. Don’t get me
wrong, the design is beautiful, but without an im-
proved battery or other charging option, video is a
non-starter for me. End result: I will keep my 4G
iPod for the moment and look forward to getting a
new video iPod sometime after the next revision.

The two devices that I want to merge are my
phone and PDA, so it is those features that I have
looked at most closely. Let’s hasten to say that we
don’t know everything there is to know about the
iPhone. Some of the features it will have were not
demonstrated. Indeed, some of the icons on the de-
vice were merely placeholders representing software
that was not yet ready for prime time or which had
yet to be developed. That having been said, there is
a minimal set of capabilities that I need. Calendar,
to-do, address book, and note-taking constitute the
basic set, and Apple surely has these in hand, but
PDA users know that though these are the essential
applications on their devices, they are not the ones
that use the most battery power. I am an avid eBook
reader because no matter where I am, I want a book
with me. I also sync AvantGo for news—yes, I saw
the New York Times, but if you’re not in a WiFi area
what will the data connection cost be on Cingular?

Prepare yourselves. These are the additional appli-
cations that one might have suspected from a host
of third-party developers but which Apple will, evi-
dently, shut out of the iPhone. We’ll see. I’m still
keeping my name on the list.

The other products that Apple rolled out at Mac-
world Expo were Apple TV and an improved Air-
Port Extreme Base Station. My immediate frustra-
tion with both was in realizing that my new MacBook
Pro, being a Core Duo, was not going to be able to ef-
fectively utilize either product because it is incapable
of supporting the 802.11n standard. It was a factor I
had not considered when deciding to buy a late Core
Duo this fall instead of waiting and getting a Core 2
Duo. Had I considered it, I think I would have done
it differently.

Much of the initial buzz about Apple TV has been
of the “it doesn’t do enough” variety. This stems, it
seems to me, from an expectation that Apple TV
would be a media center. Visions of Front Row con-
trolling the whole of an AV system danced in many
heads. The more accurate view would be to see it as
another input into the system rather than as a hub.
If one thinks of it like a satellite or cable box and
realizes that it brings media from another source into
the mix, it is easier to understand what it does, and
does not, do. In the end, the efficacy of Apple TV will
depend on the amount of media each user stores on
his computer (I’m sticking with feature-rich DVD’s
rather than downloads at the moment) and the phys-
ical reality of their individual AV components and
architecture.

So, what haven’t we mentioned? Oh, that’s
right—computers!—or, more specifically, the Mac.
Of course Steve didn’t mention the Mac much either
and that, in combination with a change in the name
of “Apple Computer Inc.” to plain “Apple Inc.,”
garnered some attention. Was Apple recognizing
that it had become a “media” company rather than
a computer company? Did this shift signal the slow
but inevitable slide away from producing computers?
Was this the beginning of the end for Macs now
that the OS is running on Intel chips and Apple has
moved into a broader line of consumer electronics?
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The short answer, of course, is that no one can
know for certain. Steve Jobs himself can’t forecast
with absolute certainty where things will be in twenty
years. However, the rush to worry about this seems a
bit overwrought to me. In the first place, speaking of
a computer company versus a media company misses
the point. Central to both is a processor and the cod-
ing to make it functional. Apple brings to the market
what no one else brings: a coherent, integrated, and
user-friendly solution to the needs that it perceives.
And who could argue that they have not done that
with style and excellence? Attending to media mar-
ket in a way that detracted from the Macintosh would
be a senseless strategy, as it would destroy the core of
the strength of Apple’s efforts. Steve Jobs signaled
as much in the keynote when he quoted Alan Kay
saying, “People who are really serious about software
should make their own hardware.”

Sitting here typing on my fourteenth Apple, I
can’t imagine what #20 will look like, but I am con-
fident that it will be there when I get there. . .and it
will just work. I don’t care what Steve calls it. A
Mac by any other name. . ..

Best wishes—and call me in June!

Copyright © 2007 Mike Chamberlain, mchamberlain@atpm.com.
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Apple Talk
by Angus Wong, atkw@anguswong.net

Safari
The death of Apple Computer, Inc. could not have
come at a more opportune time, although the skep-
tics who “predicted” it in the 1990s still had to eat
crow for the past ten years, and the “death” we saw at
Macworld Expo San Francisco made us about as up-
set as if Microsoft or Dell had gone under. Or, better
yet, seeing a brand stinking (I mean spanking) new
Zune being crushed by a speeding Tesla Roadster1.

You do remember the Zune, don’t you? You
know, that “iPod Killa” thang that was being
“launched” back in the fourth calendar quarter of
2006. Maybe it really did some killing after all,
although it sure wasn’t the iPod.

You want a real iPod Killer? I’ll tell you what
a real iPod Killer looks like: it looks just like that
hot, shiny, new, super-fantastic Apple iPhone, that’s
what it looks like! My 5G iPod sure wouldn’t mind
being killed by that, and I certainly look forward to
it. The only bad news to this whole thing? 2007 is
gonna be one long year, folks. (Is it June yet?)

I’m not going to talk about the technical details
of the iPhone here. We’ve got plenty of coverage all
over cyberspace on that. What I do want to look at is
how the entire consumer electronics and telecommu-
nications product industries totally missed the mark.
By a wide margin. Apparently, it really did have
to fall onto Apple’s shoulders to be the company to
bring this kind of product to market. The iPhone is
simply the sexiest, most advanced, most usable, and
most powerful handheld communications and com-
puting device ever created.

Even as I write this, I’m still bemused that it is
Apple, and not Nokia, Motorola, or (let’s not forget)
Palm or RIM, coming out with this product. But
then, I remember how clueless the industry can be.

Many years ago, when the original iMac first came
out, I overheard someone who was ostensibly an “in-
dustry expert” remark that he was not impressed by
“multicolored computers” and that he expected the
iMac “fad” to disappear, pronto. (He wasn’t talking
to me. I was just sitting nearby and wouldn’t have
said anything anyway, considering I owned one of
those early iMacs.) When the iMac turned out to

1http://www.teslamotors.com

be a sustained success (much to the surprise and
chagrin of these industry “experts”), PC vendors
jumped on what they thought was the bandwagon
of aesthetically-pleasing-computer-enclosures to put
out surprisingly superficial decorative casing.

And that’s where the problem lies.
Because these “experts” are not able to perceive

the true innovating factor of breakthrough products,
they can only guess at what they should be seeing,
and therefore guess wrong. They superficially see
only a colorful computer and conclude the secret
sauce must be aesthetic appeal. Then when the new
products launch they can’t figure out why the iMacs
are selling and theirs are not.

Exhibit B: the iPod. With the iPod, these blind-
sided industry insiders again can’t figure out what the
big deal is. So it’s a handheld device that plays MP3
files and syncs with the personal computer. And no
built-in radio reception. They figure they have an
exact duplicate, or better, and ignore the new kid
on the block. When the iPod became an “overnight”
sensation, they looked at the design again, which, by
then, had morphed into a colorful bouquet, and be-
gan offering music players with focus on form (but
sorely still lacking in innovative function).

We see this same thing happen with the MacBook
rip-offs. White, thin(ish) PC laptops that run Win-
dows XP Home. Or widescreen 17′′ PC laptops that
have a silvery look. Or powerful desktop replace-
ments with completely useless psychedelic lighting
that glow like a pile of radioactive waste. To make
these things “cuter,” vendors add extra toppings to
the OS in an attempt to cover up some of the Mi-
crosoft UI and stick their own branding into the box.
Totally off base.

This lack of perception, this inability to discern
the true value of a successful product (that is, rai-
son d’être of the category breakthrough, the reason
people buy the thing) is not limited to aping Apple
products. Some of you might recall Sony’s attempt
to Clie the Palm PDA, which only turned out to be
a “Cliche.” If any of you have ever used those Clie
devices, you’ll remember many of them were loaded
with Sony’s “value-added” nightmare-ware, which
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substituted the Palm OS applications menu with a
funky jog-dial-scrolling carousel. And they thought
that would be an improvement. Let’s not get into
the whole Memory Stick issue, which should be in
the same chapter as DIVX (the disc sales strategy,
not the codec) in a “stupid marketing strategies”
textbook.

I can think of many other such examples, includ-
ing the most obvious one: Windows copying the Mac-
intosh user interface.

Now, in 2006 we had the Zune trying to copy not
just the iPod but the entire iPod ecosystem. Unfor-
tunately, the ecosystem reaches far beyond what the
Zune team can ever deliver. This ain’t the Xbox—
which, essentially, took the very successful gaming
franchise that had always existed for Windows and
replicated it onto a self-contained Microsoft-branded
PC. The iPod is a totally different animal and actu-
ally ties back to the Apple brand as the producer of
machines (Macs) that create “cool” stuff. Macs, after
all, have been associated for eons with such things as
desktop publishing, video editing, and fashion design,
so it should be no surprise that the iPod is a truly
“hip” device. Trying to Astroturf Zune marketing
just won’t work because there is no way Microsoft,
as a brand, is “hip.”

(I don’t see Intel trying to be hip, and Intel
shouldn’t bother anyway. It is doing very well rein-
venting itself recently as the quiet and professional
producer of powerful engines. Even the logo had a
makeover around the time of the Apple partnership.
The new Intel of the 2000s is more of a “strong and
silent type,” as compared to the “bunnyman” brand
of the 1990s.)

So, having seen examples of what I’m calling
“clueless counterfeiting” throughout the history of
the industry, I’m thinking the trend is just going to
continue, with cell phone and PDA manufacturers
trying to rip whatever they can off the iPhone “time-
bomb” before it blows them clear out of the water.
Macworld Expo basically gave the whole world a
framework for the new smartphone. (Personally, I
think we need a new “superphone” category.) With
the iPhone, the so-called “iPod” halo effect just went
supernova, and I think Macintosh uptake is going
to accelerate even more when the new device hits
general availability.

Apple’s been paving the road map of the future
and it’s about darn time the company (and the folks
behind it) got the recognition and reward it deserves.
Many things we take for granted in computers today

were Apple innovations. It’s really exciting to see
the company’s influence expand and renovate a wider
landscape of things we use on a daily basis. HDTVs
and maybe even wristwatches are going to be next.

January 9th, 2007 marked the event horizon of a
new era of ultra-usability. I’ve written earlier that
the Mac has finally won the computing wars. Now
I’m convinced the consumer electronics, home enter-
tainment, and telecommunications industries are also
in for the mother of all battles.

Because Apple Computer is dead.
Long live Apple, Inc.
Author’s Note: this article was written shortly

after Apple’s announcement. As it went to press,
knock-offs such as the Prada Phone2 from LG have
already started to appear. It is important to keep in
mind that the Apple iPhone may ultimately feature
additional unrevealed functionality.

Copyright © 2007 Angus Wong. Angus is a long-time
Apple user and technology business professional. His
Macintosh e-mail client can most likely be reached at
atkw@anguswong.net

2http://www.lgpradaphone.com
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Next Actions
by Ed Eubanks, Jr.

A Survey of the GTD App Landscape
The 2001 publication of David Allen’s Getting Things
Done stirred a revolution of organized, productive
work environments for thousands. Allen’s system,
affectionately known as “GTD” to those in the know,
provides a framework for managing tasks, projects,
goals, and, indeed, much of one’s life.

As the GTD system spread in usage and popu-
larity, dozens of tools and writings arose as a part
of the GTD sub-culture. Blogs such as 43Folders1

and LifeHacker2 devote a significant amount of atten-
tion to implementing the GTD system. Allen’s own
company Web site3 is a haven for GTD users, com-
plete with a members-only resource center (which you
can join for a mere $40 per month).

The bottom line for GTD is fairly straightfor-
ward. How do you get things done? By determin-
ing what the next action is for any given task or
project, and keeping your focus on that. If you’re
not familiar with GTD but you’re interested in giv-
ing the system a try, I recommend that you read the
book, or check out Merlin Mann’s excellent primer,
Getting Started with “Getting Things Done”4.

Software Proliferation
Since 2005, a burgeoning market of software with the
ostensible purpose of assisting with the GTD process
has hit the Mac, and the computer world in general.
There are stand-alone applications, plug-ins, widgets,
templates, and Web sites which, in one way or an-
other, play to the desire of the GTD-oriented Mac
user for carrying out his organization in a digital man-
ner. Many of these are free or low-cost, shareware
solutions, but a larger commercial focus is arising as
a serious market.

There are, of course, a number of other applica-
tions which are GTD-friendly, if not specifically de-
signed to adhere to the canonical steps or stages of
the GTD system. Such applications also range from
the simplest widget to complex commercial applica-

1http://www.43folders.com/
2http://www.lifehacker.com/
3http://www.davidco.com/
4http://www.43folders.com/2004/09/08/getting-starte

d-with-getting-things-done/

tions, and obviously must include common task/to-
do list programs as well as large project-management
suites. These are often as good or better for certain
GTD users, since every user will implement GTD to a
different extent and, more importantly, in a different
context. Further, we all have our own peculiar work-
flows, and GTD works best (that is, it is easiest to
maintain and benefit from) when it fits into existing
workflows as much as possible.

My goal here is to give an overview of the software
tools available to GTD users, along with focused sug-
gestions for doing GTD better on a Mac. Inspired
by Ted Goranson’s About This Particular Outliner5

column, I hope to eventually offer something sim-
ilar for GTD applications here in atpm. If you
haven’t read it, you might find Ted’s overview of
task management history and theory6 a very helpful
read.

For now, I would like to start off by giving a “com-
prehensive” introduction of GTD tools. I’m shooting
for an exhaustive list here, so if I’ve missed one that
you like, feel free to mention it to me.

Web or Browser-Based Solutions
GTD TiddlyWiki

GTD TiddlyWiki7 employs the flexibility of a
wiki with the straightforward approach of GTD.
Though it uses a browser, it installs locally—it
doesn’t require an Internet connection, though I sup-
pose it could be installed on a server if you preferred
that. Because it is a single, self-contained file, it
would be easy enough to install onto a flash drive
and take it with you if you needed portability. GTD
TiddyWiki is searchable, has good print options

5http://www.atpm.com/Back/atpo.shtml
6http://www.atpm.com/10.12/atpo.shtml
7http://shared.snapgrid.com/index.html
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(including 3×5 index card), is customizable, and is
open-source. It is currently at version 1.0.6, and has
not been updated since September 2005.

MonkeyGTD and d3

Two other TiddlyWiki spin-offs that are worth
mentioning are MonkeyGTD8 and d39. Both offer es-
sentially the same features as the GTD TiddlyWiki,
with the essential differences being layout and the ad-
vantages of a newer TiddlyWiki foundation (the lat-
est revision of TiddlyWiki is 2.1.3, released in Novem-
ber 2006).

Park

If GTD TiddlyWiki is getting close to what you’re
looking for in a GTD solution, Park10 might be the
final answer. It takes the TiddlyWiki idea and local-
izes it, plus it adds on a few more features. Park is
as much a note-taker as it is a task-planner—which,
in GTD parlance, makes sense to a degree. The lat-
est version of Park includes Spotlight support, which
could be huge. Park is free, and is almost ready for

8http://monkeygtd.tiddlyspot.com/
9http://www.dcubed.ca/

10http://www.coalmarch.com/products/park.php

version 1.0, though it is currently in beta at version
0.9.

iCommit

iCommit11 is another browser-based option,
though this one does run online and cannot be locally
installed. It is something like a wiki but without the
hassle of setting up. It’s gotten a lot of good reviews
(see GTD wiz Merlin Mann’s affirming words12) but
has the downside of being “first-come, first-served”
at the developer’s private server. It is currently at
version 1.9.0, and it is free if you can get it.

MyTicklerFile

MyTicklerFile13 is specifically designed to work
with GTD—though this one incorporates a broader
concept in the GTD system. It has more explicit
syncing with iCal (and 37Signals’ Basecamp14, by the
way), and will e-mail your upcoming tasks to you
weekly for a GTD-style “weekly review.” With a
“Dashboard” view (think of this as a snapshot of
your projects and tasks), a Calendar view, a Single
Day view, and a Project view, MyTicklerFile makes
it pretty easy to get your tasks and projects orga-
nized and then work within them. It costs money
for a subscription if you want to manage more than
one project or the full set of tickler files: $9/month
gets you 15 projects, 150 reminders, and an unlim-
ited number of Ticklers, while $19/month doubles
that. You can upgrade or downgrade your plan at
any time.

11http://die-bernhardts.macbay.de/GTDV2/
12http://www.43folders.com/2006/06/27/gtd-icommit/
13http://myticklerfile.com/
14http://www.basecamphq.com/
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GTDGmail

GTDGmail15 is a Firefox extension that brings
GTD into integration with Gmail. It provides a pre-
packaged set of labels for organization, and a faster
method for applying them. It also includes a Re-
view process, allows you to save specialized searches
within Gmail (sort of like Finder’s smart folders), has
a quick-entry method for composing new tasks, and
provides a printable format (3×5 index card). The
current version, 1.31, is open-source, and obviously
requires the (also open-source) Firefox browser to be
installed.

30Boxes

30Boxes16 is an AJAX creation, which means
that it is an active application that runs within your
browser in the same way that Writely and other sim-
ilar applications do. 30Boxes is lean and fast, which
gives it an advantage over some AJAX apps. It has
a calendar, task list, and limited Gmail interaction.
It also has RSS and iCal feeds, SMS functions, and
sharing with others. The interface is nice, with a
familiar feel—it has an OS X-style “dock” on the
side to navigate among sections. 30Boxes is in beta
and is currently free.

Tasks

15http://gtdgmail.com/
16http://www.30boxes.com/

King Design’s Tasks17 is not explicitly designed
to be a GTD application. It is GTD-compatible,
though, and a free level of service is available. It
can work in collaboration with iCal, allowing you to
keep a localized version of your projects on your Mac.
It will also send you e-mail reminders of the tasks on
your list for that day, and can help you track billable
time if you need it to. To get permanent function
of the regular version requires a paid subscription,
or purchase of a server-installed setup. There is also
Tasks Jr., a locally-hosted but browser-based system,
and Tasks Pro, which is a multi-user, almost “enter-
prise” version. Tasks is a pretty good step in the
right direction for a GTD setup, particularly given
its multi-level options. Version 2.6.3 costs $30, while
version 1.6.3 of Tasks Pro ranges from $125 to $500.
Tasks Jr. is free.

Tasktoy

Tasktoy18 is a simple interface, but it lets you
categorize by context or project. You can also attach
notes to tasks. TaskToy is a similar concept to Tasks,
with fewer features. Some of the good ideas this de-
veloper has include low-resistance task building—one
or two clicks in most cases—and repeatable tasks that
are easy to set up. He has also built in mobile device
compatibility (though not with iSync, but through
the mobile service provider’s Internet access). Task-
Toy is not exactly GTD-specific, but it was designed
to be GTD-friendly. It is free, and is currently a beta
version, though it’s simply a personal project of the
developer, so it may never get out of beta.

Tracks

17http://www.kingdesign.net/tasks/
18http://www.tasktoy.com/
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Tracks19 is another open-source, browser-based
solution, though this one comes with a Web server
that allows you to run it locally if you prefer—or
have it hosted online through tracks.tra.in20. Tracks
was built with Ruby on Rails, with an AJAX face—
meaning it is fast, lean, and pretty. It also means it
can be installed on just about any platform. Tracks
doesn’t exactly work with iCal, but it does offer cal-
endaring functions—so maybe it could be an iCal re-
placement for some. It also has a multi-user compo-
nent, so it represents a great opportunity for GTD
implementation across a group or team. Tracks is
open-source and currently at version 1.043.

Basecamp, Backpack, and Ta-Da Lists

37Signals’ Basecamp21 and Backpack22 are both
very capable project managers, and both have iCal
integration. Even better, both have varying degrees
of localization—Dashboard widgets at least, and
PackRat works as a localized companion to Back-
pack. Some are convinced that Basecamp23 or24

Backpack25 is the final answer for GTD applica-
tions. For a simpler scale, you might also check out
37Signals’ Ta-Da Lists26, a basic task list manager.

19http://www.rousette.org.uk/projects/
20http://tracks.tra.in/login
21http://www.basecamphq.com/
22http://www.backpackit.com/
23http://www.hicksdesign.co.uk/journal/getting-hicks

-done#content
24http://www.punkey.com/pivot/entry.php?id=6971
25http://patrickrhone.com/journal/archives/2006/06/1

89.html
26http://www.tadalist.com/

Sproutliner

Sproutliner27 is a task list with some hierarchy
and context management. There isn’t much to
Sproutliner, but if you want a straightforward online
task list it may be satisfactory. It is open-source,
and they say it is “beta” (but they also admit that
this is as much compliance with trend as anything).

HiveMinder

HiveMinder28 has the distinguishing feature of a
“brain dump” feature, which is a one-click task cre-
ator. It also has RSS feeds, iCalendar feeds, and
printing features. It is searchable, shareable, and has
a Task Review. You can set it up to e-mail your tasks
to you. HiveMinder is free, but ad-supported; they
plan to offer a paid-for version in the future which
will eliminate the ads.

Remember the Milk

Remember the Milk29 offers as many input and
output options as any online task manager avail-
able: you can receive tasks and reminders online,
through e-mail, SMS, RSS feed, Web-enabled PDA
or smartphone, and a wide array of instant messenger
protocols. Create tasks through e-mail, even from
a mobile phone. Create recurring tasks, use tags to
organize tasks, and use the map feature to organize
the execution of your tasks. Some have brainstormed

27http://sproutliner.com/
28http://hiveminder.com/splash/
29http://www.rememberthemilk.com/
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about using Remember the Milk for GTD30. Re-
member the Milk is free.

Gmail and Google Calendar
And then there are the more general-purpose
online tools by our friends at Google, Gmail
and Google Calendar. Gmail has been adapted
into a GTD system31 and even improved upon32.
Similar work has also been done33 with Google Cal-
endar.

Local, Stand-Alone Applications
Thinking Rock

Thinking Rock34 follows the GTD model closely,
with a distinct operation for each of the three main
steps (collect, process, review-plan-do). Thinking
Rock has an interactive collection process, allowing
you to enter all of the items manually instead of
finding them for you, which is both blessing and
bane—after all, manual entry of all of your projects
is a lot of work, and is sometimes redundant. One
big thing I like about Thinking Rock is that it is
easy to enter lots of new tasks at once: the collection
stage is as simple as typing a brief description, then
tabbing or pressing Return a couple of times to a
new line. It also has the nuance of being a Java
application, making it very portable: you can install
Thinking Rock onto a flash drive and use it on any
computer, any platform. Because it’s Java, it doesn’t
feel like a Mac application—but neither does it have
the clunkiness or sluggish operation that many Java
applications have. At version 1.2.3, Thinking Rock
is established and bug-tested.

30http://www.geektronica.com/2007-01-15-gtd-with-rtm
-getting-things-done-with-remember-the-milk

31http://saw.themurdaughs.com/gtd-with-gmail-whitepa
per/

32http://www.designpattern.org/wp/?p=56
33http://www.isaacbowman.com/gtd-with-googles-new-ca

lendar
34http://www.thinkingrock.com.au/

Midnight Inbox

Midnight Beep has been working hard over the
past few months to get Midnight Inbox35 out the
door; it’s currently at version 1.0.5, with a price at
$35. Inbox is a top-to-bottom implementation of
the GTD system. What is more, Inbox is a well-
designed application with a beautiful Mac-like inter-
face, and I’ve been assured that iCal integration is
on the way. Inbox is sort of a “meta-application”:
it gathers events and tasks from iCal, messages from
Mail, and other documents, bookmarks, notes, and
other files and allows you to process them through
the GTD model—collect, process, review-plan-do. It
gathers them on its own, by the way—which is both
blessing and bane; to build a project from scratch re-
quires going through iCal, Mail, etc. You can monitor
your progress, archive projects that are completed,
and organize your work patterns. In a way, Inbox
represents your personal David Allen36 coaching you
through your projects; there are a handful of nice
features, like the processing timer, that help a serious
GTDer keep focused. One thing Inbox gets right that
the others sort of miss: GTD is more than mere task
management, and Inbox’s “meta” quality addresses
this more thoroughly than any other available appli-
cation. But this may be more function than you need
in a task-management environment, and if so then In-
box may feel a bit over-done.

KinklessGTD
KinklessGTD37 is one of the original GTD “apps,”
although it isn’t itself an actual application. Rather,
KinklessGTD (kGTD) is an elaborate template and
AppleScript set built by Ethan Schoonover for Om-
niOutliner Pro. kGTD takes full advantage of the
outliner’s ability to make greatly detailed lists, and

35http://www.midnightbeep.com/
36http://www.davidco.com/david_allen.php
37http://www.kinkless.com/
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allows hierarchical project organization to flow. As
with most GTD systems, kGTD allows you to view by
Project, Context, or Next Actions. It syncs with iCal
after some modest setup, and also can receive input
through Quicksilver; thus, it also has an Inbox view
that lets you organize those stray tasks that haven’t
yet been placed into a project or context. Through a
bit of finagling and the help of Mail Act-On, it’s pos-
sible to have kGTD indirectly sync with Mail; but
more on this in another article.

kGTD has captured the love and affection of some
big names, including Merlin Mann, who has written
a number of posts on mastering the FU of kGTD38,
and inspired the Omni Group to begin building
OmniFocus39, which is due out sometime this year.
Still, KinklessGTD is a little buggy, and it’s un-
likely that Ethan will build another version, since
he is apparently working with Omni on OmniFocus.
Thus, it may be that the current version, 0.83,
is all we get—which will be plenty for some, but
not for everyone. KinklessGTD is free under the
GNU public license, though it requires purchase of
OmniOutliner Pro40 (no, it won’t work with the
free copy of OmniOutliner that came on your Mac),
which costs $70.

Frictionless
If the name Frictionless41 sounds like a play on the
KinklessGTD name, you’re spot-on. It was developed
as a stand-alone rendition of Kinkless, with a goal to
create the same basic tool-set of an outliner/task-
planner. As such, the developer included the abil-
ity to import projects and tasks from Kinkless GTD.
Frictionless is possibly the most thoroughly GTD of
all of the GTD applications. It is fairly easy to collect
and gather, and new tasks go immediately into a flat
file of actions. These can be organized into subsets
of each other, creating a hierarchy of projects and
sub-projects. A lot of this can be done via keyboard

38http://www.43folders.com/topics/kgtd/
39http://blog.omnigroup.com/2006/09/25/omnifocus-our

-work-in-progress/
40http://www.omnigroup.com/applications/omnioutliner

/pro/
41http://www.twinforces.com/Frictionless/Frictionles

s.html

or mouse, so that proficiency with the system could
mean very fast organization of new projects.

A Next Actions window is ready to give context-
specific counsel about tasks, and the This Week win-
dow allows for very easy weekly reviews. David Allen
would be proud. Frictionless also has Quicksilver in-
tegration, which instantly moves it up a notch or two
for many hardcore Mac users, and, frankly, for a lot
of GTD Mac folk already adapted to Kinkless. And
it has an AppleScript that allows an action to be cre-
ated directly from Mail. Frictionless lacks the abil-
ity to sync with iCal, but this may be covered by
the Quicksilver and Mail actions, and the developer
promises that it is on the way.

When you open Frictionless, a lot of windows
show up at once; no fewer than four windows have
a regular function in the application. It’s easy
enough to Command-tilde through them, and each
of them has a Command-# hotkey assigned. Still, it
seems like a lot of windows to me, even though each
has a specific and important function in the GTD
system. While the application generally feels very
Applicious, the large number of important windows
makes Frictionless feel a little cluttered. The current
(free) version is 0.8.4, and it hasn’t been updated in
a while; hopefully we’ll see more from Frictionless
very soon.
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Ready-Set-Do!

Ready-Set-Do!42 is a fair departure from the rest
of the GTD applications. Rather than function as a
task manager per se, Ready-Set-Do! functions like
a virtual version of the paper method of collecting,
processing, and review-plan-doing. Ready-Set-Do! is
an extensive set of AppleScripts that transforms your
Mac’s desktop into a GTD processing station. It in-
tegrates with iCal nicely, and allows a “whole sys-
tem” approach that isn’t possible with any of the
other GTD applications—only Midnight Inbox comes
close. For those who can handle a true paperless of-
fice, Ready-Set-Do! may be the one-stop solution.
Currently in version 1.0, Ready-Set-Do! costs $20 for
a single-user license.

Action Tracker

Action Tracker43 isn’t exactly a stand-alone ap-
plication; instead, it is a FileMaker Pro document.

42http://homepage.mac.com/toddvasquez/Ready-Set-Do!/
Personal93.html

43http://macproductive.com/actiontracker.html

But it is a well-designed GTD environment. Action
Tracker is, like Inbox, more than simply a task man-
ager; instead, it serves as an interface for your project
management. In addition to a very complete task and
project management element, it also organizes notes,
contacts, and other files related to the project, and
it can create iCal events as well. Jumping between
entry mode and list-view mode is easy, and an added
bonus is that it has a 3×5 card printout function—
any item or list can be dumped onto an index card.
Action Tracker 1.3.1 is free, and if you don’t have a
FileMaker Pro license, a runtime version is available.

Actiontastic

Though still in beta, Actiontastic44 is a simple
yet capable task manager, and an ultra-thin one at
that. Actiontastic is, like many betas, a fairly bare-
bones application that the developer wants to make
something more of, though recent beta releases are
considerably less “bare-bones.” As it is, three tabs
offer you views of the inbox, projects, or contexts.
Creating a new item in the inbox allows you to enter
a line of text, then select whether it is an action or
a project; you may utilize the Inbox tab as a collec-
tion of sorts, and a “Process Inbox” engine will help
you through the processing phase. There is also a
Quicksilver plug-in, and Actiontastic will sync your
tasks to iCal or an iPod. Future plans include print-
ing/other export methods. The beta version is free,
with a stated expiration date. It is currently at ver-
sion 0.9b.

44http://www.kaboomerang.com/blog/category/actiontas
tic/
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EasyTask Manager

OrionBelt’s EasyTask Manager45 rounds out the
list of explicitly GTD applications. EasyTask Man-
ager is another stand-alone application that has some
maturity, with version 1.7.6 available for $20. Easy-
Task Manager is well-named: it manages only tasks,
and it does so easily. It has a lot of heavy GTD in-
fluence, though (unlike Inbox and Frictionless) you
could certainly use it if you weren’t familiar with the
GTD system. Tasks can be sorted by project or cat-
egory, and they can be assigned due dates, priorities,
and notes. It will sync with iCal, either by only im-
porting tasks from iCal or by a bi-directional sync.
A calendar function makes it easy to perform regular
daily and weekly reviews, and heavy drag-and-drop
ability makes for easy sorting and categorization in
process stage.

Ghost Action

Ghost Action46 from Ghost Park Software sports
a simple, single-window interface with tabs for Con-
texts, Projects, and Actions. Ghost Action will sync
with iCal and .Mac, and will also sync with a PDA
or phone through iSync. Still in beta (1.0b13), the

45http://www.orionbelt.com/
46http://ghostparksoftware.com/

developer is planning to include printing, a unified
look (currently showing brushed metal), and a more
general Inbox implementation.

Mori

Those looking for a note/document organizer as
well as a GTD application might appreciate Hog Bay
Software’s Mori47 along with the mGTD plug-in48.
Mori is one of a handful of “digital notebook” appli-
cations, complete with Spotlight functionality, Apple-
Scriptability, and a growing collection of plug-ins to
make research, writing, or project management eas-
ier. The mGTD plug-in brings a thorough GTD sys-
tem into Mori, though it does not sync with iCal.
The mGTD plug-in (current version: 1.2 “pre-final”)
is free, but Mori (current version: 1.4) will cost you
$40.

Life Balance

Llamagraphics has one of the most mature task-
management applications, Life Balance49. Currently
at version 3.2.9, Life Balance offers a sort of “meta-
feedback” about your tasks: how much time are you

47http://www.hogbaysoftware.com/product/mori
48http://www.hogbaysoftware.com/node/1385
49http://www.llamagraphics.com/LB/LifeBalanceTop.htm

l

ATPM 13.02 27 Next Actions: Survey of GTD Apps

http://www.orionbelt.com/
http://ghostparksoftware.com/
http://www.hogbaysoftware.com/product/mori
http://www.hogbaysoftware.com/node/1385
http://www.llamagraphics.com/LB/LifeBalanceTop.html


spending in different areas of your life (i.e., work, fam-
ily, hobbies, etc.), and are you keeping it balanced?
Experienced GTD users might point out that this
is a fairly high-level GTD checkpoint. Life Balance
also has the benefit of being developed for Mac OS X,
Windows, and the Palm OS, so you could conceivably
have it with you in nearly any circumstance, even if
your work computer is not a Mac—though this would
not be a necessary benefit if Life Balance were not a
completely closed environment, without iCal integra-
tion. Still, Life Balance is a popular and established
option, if not explicitly designed for GTD. Life Bal-
ance for the Mac costs $65, or $80 if bundled with
the Palm OS version.

ZooDo

ZooDo50 is a basic task-creator for iCal. It
is a stand-alone application, but it serves as the
“collection bucket” of sorts. Certainly helpful in
the gather/collect stage of planning, ZooDo is par-
ticularly friendly to those who prefer keyboard
interaction to a mouse/keyboard combo. Some
folks have brainstormed about how this makes
GTD easier, particularly with regard to further
integration with Backpack51.

50http://interfacethis.com/zoodo/
51http://factoryjoe.com/blog/2006/02/01/zoodo-for-gt

d/

ToDo

ToDo52 is a free, basic to-do list application. De-
signed to integrate into an existing workflow, ToDo
is low-profile but still packs a fair amount of punch.
Quicksilver users can utilize a ToDo plug-in to quickly
enter new tasks, and limited integration with Address
Book and iCal means that some redundancy is re-
duced. .Mac support means that you can sync To-
Dos on multiple Macs, and AppleScriptability allows
creative integration with other applications. ToDo
also supports file attachments, so if there is some-
thing pertinent to a particular task it can be linked.
Categories of lists allow ToDo to serve particular con-
texts, and ToDo generally is GTD-friendly, but is not
specifically aimed at GTD users.

High Priority

High Priority53 is a system preference pane and
creates a menu item in the menu bar. With High
Priority, you can create and update your iCal tasks.
High Priority is currently at version 1.11 and costs
$6 for a personal license (family and business licenses
are also available).

52http://www.jimmcgowan.net/Site/ToDo.html
53http://www.kudurshian.net/highpriority/
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iClock

Another utility similar to High Priority is Script
Software’s iClock54, which actually brings a host of
new services and functions with it. iClock doesn’t
have iCal interaction, but it does offer a menu bar-
based method of managing task lists. iClock is at
version 3.0.5 and costs $20.

To-Do X

To-Do X55 is another stand-alone task manager,
and while it will import tasks from iCal, it has no
further interaction with it. To-Do X offers a number
of good features for a task-manager, including cate-
gories (which could double as “contexts”), priorities,
and attached notes. To-Do X also imports from the
Classic OS Desk Accessory ToDo!. Version 2.1 costs
$15.

54http://www.scriptsoftware.com/iclock/iclockmac.php
55http://www.nomicro.com/Products/ToDo/

Stapler

Stapler56 is a combination of a basic notepad and
a to-do list manager. It is very simple in orientation:
creation date, notes, and a check-box for completed
items. Tasks can be color-coded based on a low-level
preference setup. Stapler is not really designed for
GTD, but it could work for the right user. €7.50
(about $9.70) gets you version 1.1.

What’s Next
In the next few articles, I’ll work through the “essen-
tial” features of a GTD application according to the
canonical system, and consider which of these is re-
dundant elsewhere (and therefore possibly optional).
I’ll talk about different workflows and how the vary-
ing GTD apps fit into them. And I’ll discuss some of
the larger-scale project managers, such as Jumsoft’s
Process257 and the OmniGroup’s OmniPlan58.

Copyright © 2007 Ed Eubanks, Jr.

56http://www.blue-tec.com/stapler/
57http://www.jumsoft.com/process/
58http://www.omnigroup.com/applications/omniplan/
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Photoshop For the Curious
by Lee Bennett, lbennett@atpm.com

An Overview, Part 3
Palette Mania Redux
Last month1, I revealed that I leave nearly all of Pho-
toshop’s palettes open on my office Macintosh and
logically arranged on a secondary monitor. I had in-
tended to show a screen shot of this arrangement, but
I wrote last month’s column while on Christmas hol-
iday break and didn’t have access to my office com-
puter:

A sample arrangement of nearly all Photoshop’s palettes.
(click to enlargea)

ahttp://www.atpm.com/13.02/images/ps-all-palettes-l
arge.png

Don’t take the above arrangement as a suggestion
from me. Rather, it’s simply a palette arrangement
that works for my situation. If you have a secondary
monitor and wish to have all the palettes open, you
should definitely experiment and reposition to find
what’s best for you. Notice that I’ve still got some
palette tabs grouped into one window, and that some
of the vertical columns of palettes are attached to-
gether using the steps I described last month. For
the record, the only reason my Actions palette is not
attached to the Info palette is because the height of
the Info palette increases when color samplers are set,
and I don’t want my Actions palette to shift down-
ward when that happens.

1http://www.atpm.com/13.01/photoshop.shtml

Moving along, it’s now time to glance in each of
the Photoshop menus and learn some of the tasks for
which they’re used. Bear in mind, menu items some-
times replicate features found in the palettes. In addi-
tion, right-clicking (or Control-clicking) areas within
an image generally produces a contextual menu con-
taining the most relevant menu functions. As you
become more proficient with Photoshop, you’ll find
yourself pushing your mouse up to the menu bar less
and less frequently.

Application Menu
The first menu is one with which you should already
be accustomed. It’s the Application menu, and it’s
where—like in any other application—you access the
opening splash image, preferences, commands to hide
or quit the application, etc.

Secret About Box
Since the very beginning, Photoshop has featured
an easter egg known as the Secret About Box.
Hold down the Command key while selecting About
Photoshop. . . to access it. It generally always con-
tains some sort of humor as well as the development
code name of that particular version of Photoshop.

Adobe Space Monkey!
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Preferences
A whole series of columns over several months could
be devoted to Photoshop’s preferences. Not to worry,
though. It’s not going to happen here—at least not
soon.

Photoshop’s default preferences are fine for most
people, but you should definitely look through them
all (note that there are nine different panels within
the Preferences window) and adjust any that make
sense to you. If you don’t understand a preference,
even after hovering your mouse for the tooltip, just
leave it be.

If you’d like a little guidance, here are some set-
tings I often recommend to people. Your mileage may
vary:

• If you don’t want your palettes going back to
the default after you’ve carefully positioned
them where you want them and saved them
into a workspace, be sure to check the Save
Palette Locations box in the General section.

• In the Display & Cursors section, try setting
Painting Cursors to Normal Brush Tip with the
Crosshair option checked, and set Other Cur-
sors to Precise. The Standard setting just uses
a representation of the selected tool’s icon and
is very unhelpful to me when editing my images.

• If you have a separate hard drive that’s larger
and/or faster, you can tell Photoshop to use
it for temporary scratch space in the Plug-Ins
& Scratch Disks section. This is great for lap-
top users who would rather let a faster external
drive be the one to get Photoshop’s heavy use
instead of the slower internal laptop drive.
For the benefit of those who don’t know what
scratch space is, Photoshop couldn’t possibly
do all it has to do just within the confines of
available memory. To combat this, it writes
data to temporary space on your hard drive, it
does so a lot, and it’s actually pretty good at
managing it. But it works all the better when
there’s plenty of elbow room and it’s on a fast
hard drive.

File Menu
Most of Photoshop’s File menu is just like any other
application’s, with items to open, close, save, print,
and create new documents. Note that this month’s
article isn’t going to elaborate on every single item in

every single menu, but we’ll go over a few items that
can be fun to play with.

Automate
In the File menu, you’ll find the Automate submenu.
Adobe has provided a number of fun tools here. We’ll
look at some of them in greater detail in the future,
but there are two that I use most frequently. The
first is Web Photo Gallery. . ., which provides an in-
terface for generating a self-contained folder with all
the images and HTML files needed for a basic Web
gallery. It nearly always takes me a bit of trial and
error with the settings to get the gallery exactly how
I want it, so I recommend first testing your settings
with a folder of only about a dozen images. When
you’ve got it right, then just run it again on a full
folder of images.

My favorite item in the Automate menu is
Photomerge. . ., which does exactly that—merges
two or more photos into a single shot. I plan to
devote a future month’s column to Photomerge. For
the time being, I’ll say that, with practice, it works
better than any merging function I’ve used that
comes free with consumer digital cameras.

Edit Menu
Just as with the File menu, the Edit menu is one you
find in almost any application and is where the Cut,
Copy, Paste, and Undo commands live. Photoshop,
however, beefs up these basic commands with func-
tions to step forward and backward through an Undo
history, as well as functions that perform copying and
pasting as they would pertain to Photoshop’s layers
and selection areas.

The Edit menu is where Adobe has placed com-
mands for Stroking (outlining) and Filling a selec-
tion with a color or pattern; Transforming an image
by skewing, rotating, scaling, etc.; and working with
advanced color profile settings.

The bottom of the Edit menu contains two very
important features for customizing Photoshop. The
Keyboard Shortcuts. . . item allows you to add, re-
move, and change keyboard shortcuts assigned to var-
ious menu functions. With the Menus. . . item, you
can choose to hide functions found in the menu bar
that you never use and just get in your way. You can
also colorize them and change the order to help you
find them.
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Image Menu
The Image menu contains functions that generally
affect your entire image—often, but not always, af-
fecting all layers of the image.

Mode
The Mode submenu is where you choose whether
you want to work in RGB (Red, Green, Blue) mode,
CMYK (Cyan, Magenta, Yellow, Black), Grayscale,
and other color modes. Commercial printing presses
generally prefer that photos are saved in CMYK
format. Otherwise, you’ll generally always want to
be in RGB mode since some Photoshop functions are
not available in CMYK mode. If you’re working on
images to put in a video (e.g. you’re using iMovie),
keep in mind that video is also RGB.

The Grayscale mode will convert your image to
black and white (grayscale is a more accurate term
since there is also a Bitmap mode, which truly is
black and white—with no shades of gray). But before
just selecting Grayscale mode, there are ways you can
make your grayscale photos look much better—and
that’s this month’s tutorial which I’ll cover after this
menu overview.

Adjustments
This powerful section of the menu bar is where you
get to be the photo lab technician and tweak the color
hues of your image. It’s here that you’ll find Pho-
toshop’s very basic Brightness/Contrast command,
which works in a pinch, but in an upcoming column
we’ll look at the Levels and Curves tools that offer
far better control than Brightness/Contrast.

Modifying the Entire Canvas Window
The Adjustments submenu is also where you can scale
the size of your image, increase or decrease the size
of the canvas window around your image, and rotate
your image. Yet another topic for a future column is
using the Image Size command—specifically regard-
ing the Resolution setting and the difference between
whether or not the Resample Image item is checked.

Layer Menu
The Layer menu contains, as you would probably
guess, functions that affect individual layers of your
image. As such, some of its functions are unavailable
if your image is flattened into a single background
layer. Other than creating, removing, and duplicat-
ing layers, most of the Layer menu functions can be
a bit on the advanced side, and we'll cover them as
needed.

Select Menu
When you use the Marquee Selection Tool or the
Magic Wand or in some way create a selection, the
Select menu is where you’ll find things that you can
do to tweak your selection, as well as tools for mak-
ing a new selection in ways you might not ever have
thought of. Remember—this menu only deals with
selections and not your actual image. In theory (and
I say this because I welcome correction if I’m wrong),
anything you do in the Select menu does not imme-
diately change your image.

The first portion of the Select menu simply offers
commands to select the entire image, deselect any
current selection, reselect whatever was last selected,
and completely inverse your selection.

The next portion helps control your selection
when dealing with multiple layers.

Color Range. . . is a nifty selection tool that will
create a selection based on colors in your image. Its
tools allow you to isolate a single color, or to drag an
eyedropper across a portion of your image to make a
range of colors the selection.

For this image, I have activated the additive eyedropper (the
one with the + symbol) and dragged it across the blue sky.
As you can see, in addition to selecting the entire sky, the

same blue shades were also found in the lower portion of the
image. However, these erroneous and unwanted selections

can easily be removed, leaving just the sky selected.

Next are several options for changing your current
selection. Feather. . . softens/blurs the edges of your
selection by a number of pixels you specify.

In the Modify submenu, Border changes your se-
lection to only include an outline of the selection as
many pixels wide as you specify. Smooth will reduce
sharp angles in your selection within a threshold of
a specified number of pixels. Expand and Contract
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enlarge and reduce, respectively, your entire selection
by a specified number of pixels.

The Grow command can be a little tricky to un-
derstand, but it’s fairly simple once you get the hang
of it. Suppose you’ve made a selection with the Magic
Wand with a five-pixel tolerance. Using Grow will ex-
pand your selection an additional five pixels.

The Similar command is also fairly simple in its
function. It expands your current selection to include
other areas of the image with similarly colored pix-
els to what is already selected. Note that it selects
noncontiguous pixels, which means you may have a
selection over on the right side of your image and the
Similar selection command could add an area over on
the left side of the image to the total selection.

The Transform Selection command is essentially
identical to the Transform command found in the
Edit menu, except that it only affects your current
selection.

Finally, the Load and Save Selection commands
store and recall selections for later use. When you
save a selection, a new channel is created to hold that
selection and can be seen in the Channels palette.

Filter Menu
Photoshop’s collection of filters is another area to
which I’ll devote a future column. Feel free to play
with some of them. The function of many are pretty
obvious from their names, such as Sharpen and Blur.

View Menu
The upper portion of the View menu involves ad-
vanced color management, so we’ll skip that for now.
The next section contains the Zoom In and Out com-
mands along with a few default zoom levels.

The Screen Mode submenu is identical to
the Viewing Mode selector I described in the
Tool Palette overview2 in December. I suppose I
erred in calling it Viewing Mode when it is actually
called Screen Mode.

The remainder of the View menu adjusts settings
for alignment guides and grids, and for slices. Don’t
worry about guides and grids for now—and remem-
ber that we’ve already established that slices are one
of Photoshop’s advanced features and are used when
preparing Web pages.

Window Menu
In a sense, we’ve already covered much of this menu
last month because it mostly contains items for en-

2http://www.atpm.com/12.12/photoshop.shtml

abling or disabling Photoshop’s palettes. This is also
where you can save and recall custom workspaces,
rearrange all currently open image windows, and
quickly activate a specific image window.

Help Menu
Oh boy, do I really have to go here? Well, OK. Ob-
viously, this is where you access Adobe’s help engine
for Photoshop. Take my advice. Use it! Even if you
don’t have an immediate problem with something, try
picking a particular feature of Photoshop and read-
ing the help documents about it. You’ll be surprised
what you learn.

Also in the Help menu are functions to handle
your registration license and manage software up-
dates.

Put ’em All Together
That wasn’t so bad, was it? I do have to say, as
someone who has used Photoshop since version 2.5,
the placement and groupings of menu items has con-
sistently improved with each major version of Photo-
shop. If you still don’t like it, Adobe even now allows
you to change the menus around however you see fit.
There are even a couple of alternative menu bar sets
already defined that you may wish to check out.

Better Grayscale Tutorial
OK, time to actually learn something practical. Years
ago, a quarterly newsletter I design mostly contained
only grayscale (black and white) photos. To convert a
color photo, I would, as you’ expect, head to the Im-
age . Mode . Grayscale command. Then, I’d spend
time playing with the tonal curves to increase con-
trast and make it look like a decent photo.

Today, the same newsletter I design is entirely
in color and I don’t often print grayscale photos any
more. But, when I do, I’ve discovered some new steps
to make them look a lot better than simply switching
the color mode to grayscale.

We’ll start with a standard digital photo. In
this color version, the saturation has been increased
slightly from the original.
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Yellowstone looks great in color, but let’s get all Ansel
Adams on these bison, shall we?

This grayscale conversion isn’t all that bad, but likewise isn’t
all that great.

In the past, I would’ve simply changed to
grayscale mode, which produces a reasonable photo,
but the contrast is generally not spectacular.

Sure, you could get out the Brightness/Contrast
tool and increase the contrast. Let’s see what hap-
pens.

With the contrast bumped, our image starts to look better,
but we’ve completely blown all the detail out of the band of
cloud near the top of the image, and the shadowy portion of
the grass in the foreground has gone black, having also lost

all its detail.

We can achieve better grayscale results by simply
adding one small step before switching to grayscale
mode. Back at the original, newly opened color im-
age, head to the Image . Adjustments . Channel
Mixer command. Check the box at the bottom la-
beled Monochrome.

Boom (with apologies to Steve Jobs). Look at
that sky. Look at the shadow detail in the grass at
the bottom. Okay, okay, none of us are likely to be-
come the next Ansel Adams, but this image now looks
pretty darn good, if I do say so myself.

In the case of using the Channel Mixer to convert a color
photo to grayscale, you can have your cake and eat it, too. In

other words, you can quickly and easily apply impressive
contrast while not completely blowing out detail in the

brightest highlights and the darkest shadows.

After checking the Monochrome box, most pho-
tos will do great simply by leaving the Red slider at
100% and the Green and Blue sliders at zero. Tweak-
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ing them by subtle amounts might achieve even bet-
ter results. As always, your mileage may—and very
likely will—vary significantly.

Once you’re satisfied, now it’s time to hit the
Grayscale mode in the Image menu. Voila!

Next Month. . .
Here’s your homework assignment. First, open copies
(remember, always keep original versions of your im-
ages) of some of your favorite photos and experiment
with the various options in the Image . Adjustments
submenu. Some will produce a control window with
adjustments. Others will simply do the command
with no interactivity. Make a prediction of what
you think will happen before invoking each command,
then take note of what actually happened.

Big reminder: besides any original, unaltered
JPEGs from a digital camera, you should also save
Photoshop .PSD files so as not to add additional
compression to your work. Save flattened JPG copies
from the Photoshop document as needed. Alterna-
tively, you can save as TIFF, which also does not add
compression artifacts and is more compatible with
other graphic applications that won’t open Photo-
shop files. The drawbacks are that layer support in
TIFFs can be unpredictable, and that single-layer
TIFFs are larger in file size than single-layer .PSD
files.

Now that I’ve completed the introductory
overview, it’s getting to be about the right time
to make sure your monitor is set to display colors
reasonably accurately. While it’s true that using
a stick-on sensor that measures color output is the
best way, such a device is really only needed when
doing professional color output. For your purposes.
Mac OS X’s built-in tools for color calibration will
suffice, and we’ll learn how to do that next month.
Once you’re seeing your photos’ colors more accu-
rately, we’ll be in good shape to also take a look at
Photoshop’s Levels control and learn why it should
be your choice over the Brightness/Contrast control.

Copyright © 2007 Lee Bennett, lbennett@atpm.com.
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How To
by Chris Dudar, PhD

Demystifying the Uninterruptible Power Supply
(UPS)
What is an Uninterruptible Power Supply (UPS), do
you need one, and if so how do you decide what you
need? At its most elemental level a UPS is simply a
charged battery that delivers enough power to your
computer, and other critical hardware such as a mon-
itor, to save and close current files and properly shut
down the operating system when the primary power
source has failed, such as in a blackout. The answers
to the second and third questions depend on how you
use your Mac and on your hardware requirements,
but there are some basic principles that will be cov-
ered in this article to hopefully get you on the right
track. I will not be telling you which type of UPS, or
even which UPS brand to buy. After reading this you
should be somewhat more informed, or at least have
a head start on where to go for additional research.

Do You Need One?
Have you ever been sitting in front of your monitor,
immersed in whatever creative process you happen to
subscribe to, and failed to save those ever-so-clever
adjustments to a file when the lights went out? It
feels like you can never quite get it back to the way
it was, right? I bet you wish you had a UPS.

If your desktop Mac activities would involve the
loss of irreplaceable mission critical information in
a power outage, such as in any business environ-
ment, then you definitely need at least a UPS if not
a UPS/back-up generator combination depending on
the scale of your system or network. Even if you
use your Mac at home for more recreational pursuits
and already have a good (not cheap) surge protector,
you may still suffer hardware damage or lose valu-
able files if power to the drive is interrupted while,
say, updating your operating system or simply mov-
ing some family photos from your camera. If you have
a laptop then you already have a built-in battery, but
there are still many advantages to using a UPS, such
as power conditioning1.

1http://en.wikipedia.org/wiki/Power_conditioner

Businessweek.com cites a 2004 survey2 by Emer-
son Network Power that reports 75% of small business
owners feel power outages are a threat to their ven-
ture, yet 62% still do not have a backup power supply.
The same study also found that of the 80% who have
experienced power outages, over 14% reported that
their longest outage cost $5,000 or more.

While there are several preventive strategies for
avoiding the problems brought about by power out-
ages, such as regular data backups and generators,
this article is about the immediate first line of de-
fense provided by the UPS. I will describe my UPS
experiences with desktop Macs, and then try to be
informative, yet brief, about how to determine your
requirements and choices in the market.

My UPS Experience, Or, Why I Ended Up
Writing This Article For ATPM
After shelling out the big bucks for a G5 Quad
Power Mac, I decided that a UPS was in order since
I was starting to work from home on 3D graphics3

and animations and didn’t want to lose important
file changes or renders in mid-run because of power
failures. Contrary to my normal routine of research
first, I went down to one of the local big box retailers
to browse the UPS selection—after all, how complex
could it be, right?

I read the box literature describing connected
equipment warranties, VA capacity, output wave-
form, and backup capabilities etc., etc. In the end
I picked up the largest one available in the store to
give it a try, a Belkin Enterprise 1200VA (currently
discontinued). In defense of my actions, this UPS
was listed on the box as “ideal” for Power Mac G5
processors.

I quickly found out that I had some misconcep-
tions about what this UPS could do for me and my
G5 Quad. For instance, the purported battery power
supply of up to 100 minutes for the 1200VA actu-

2http://www.businessweek.com/smallbiz/content/jul20
06/sb20060724_304827.htm?chan=search

3http://www.atpm.com/13.01/daz.shtml
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ally provided less than 10 minutes for me with only a
19 inch LCD monitor as additional peripheral hard-
ware. Obviously the Quad was no ordinary computer.
I knew that, but just how much of a power-hungry
beast it was surprised me. It became apparent after
my post-purchase research that if I wanted a longer
battery charge to finish off big renders then I would
have to pay big bucks beyond my post-Quad budget
and meager supplementary income from the graphics
work.

The Mac OS X UPS settings, found in the Energy Saver
pane in System Preferences.

However, I received a real shock (figuratively, not
literally) when we had a power failure a few weeks
later and the Quad was in sleep mode. I had the
Mac OS X UPS settings, found in System Prefer-
ences . Energy Saver . Settings pop-up menu, set
to shut down the computer after only a few minutes
of battery power since I knew the 1200VA could not
handle much more than that. But nothing happened!
I checked to make sure the USB cord was connected
to the UPS and computer, and it was, so I went to
wake it manually to shut down properly. That’s when
all hell broke loose: all nine cooling fans went super-
nova, the red warning light came on inside the front
grill for the power supply, and the monitor was black.

I had never experienced anything like this be-
fore, and in my adrenaline-enhanced state thought
the Quad was going to blow something very expensive
to replace. I quickly pushed and held down the main
power switch for a hard shut down. There was noth-
ing else to do. The same thing happened two other
times during power failures. I did a bit of digging

here and there, and I found that peak power require-
ments at startup, or waking, exceeded the capacity of
my UPS. However, nobody could tell me how much
power the Quad needed at these critical times, since
all computer data I could find states normal opera-
tional requirements.

Flash forward to Fall 2006. I sold my G5 Quad
(never could stomach the knowledge that the liquid
cooling system sat above the power supply) and pur-
chased a 2.66 GHz Mac Pro. Perhaps it was fate, as
the power went off with the Mac Pro in sleep mode a
few weeks later, so I got up to see what was going to
happen this time. Again, the OS X UPS shutdown
settings did not activate when in sleep mode, so I had
to wake the unit to shut down properly. To my sur-
prise it powered up normally, but I didn’t have the
monitor plugged into backup UPS power, so I had no
screen, and subsequently plugging the monitor into
backup power did not result in a video connection for
whatever reason.

I was half-awake so I instinctively pushed the
main power switch for a hard shut down, but failed
to hold it down long enough this time, so it just
went to sleep again. I can laugh now, but I wasn’t
very happy with myself at that moment, and instead
of just trying a hard shut down from sleep I ended
up waking the computer again. To my utter amaze-
ment, the Mac Pro woke from sleep a second time
on UPS battery power with no problem! I had read
that the power efficiency4 of the Intel-chipped Macs
was a vast improvement over the G5s, and here was
first-hand proof.

Different Types of UPSs
There are a plethora of Web sites that provide de-
tailed information and schematic diagrams of the var-
ious types of UPSs, so I will not go into too much de-
tail. Readers requiring more information should con-
sult the Pacific Gas and Electrical Company article5,
or the BC Hydro UPS Guide6, as I found these very
comprehensive and concise. PC Guide7 provides an
insightful table comparing the different types of UPS
and other protection offerings versus some common
power problems, and you should look at it if you are
making a decision to buy a certain type of UPS. The

4http://www.macworld.com/2006/08/reviews/macprorev/
index.php

5http://www.pge.com/docs/pdfs/biz/power_quality/pow
er_quality_notes/ups.pdf

6http://www.bchydro.com/rx_files/psbusiness/psbusin
ess23447.pdf

7http://www.pcguide.com/ref/power/ext/comp-c.html
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Holy Grail of online UPS FAQ links can be found at
JetCafe8 and I highly recommend that you print this
document and save it for reference.

While there is some variation within each type, in
a nutshell, there are three varieties of UPSs: Standby
(or offline), Line Interactive, and Online. Each con-
tains a battery, an AC-DC battery charger or recti-
fier, and a DC-AC inverter to take battery power and
provide it in a useful form for your computer.

A Standby UPS provides main AC power directly
from the wall socket to the computer, but in the event
of an outage a transfer switch activates the secondary
battery circuit. This results in a 1 to 5 millisecond
power interruption, which is at the tolerance limit of
a typical computer power unit. These are the least
expensive of the UPSs.

Line Interactive UPSs also rely on main AC power
for the computer during normal operation, but have
a bi-directional charger/inverter. When power fails,
the bi-directional unit switches to inverter mode to
provide battery power. Since the charger/inverter is
functionally always on, switching times are minimized
compared to standby UPSs. The efficiency of these
units is between 90 to 96%.

Online UPSs convert all the main AC power to
DC, and then convert it all back to AC power before
it is supplied to your computer. Thus it is always
in the same operating mode so there are no power
interruptions. In this way they also effectively fil-
ter line noise and other power anomalies, but at a
cost. Efficiency is reduced to 80 to 90% with heat
as a bi-product. These units are typically the most
expensive.

How to Calculate Your UPS Needs
I must first say that the following information is pro-
vided at your own risk, and geared to a North Amer-
ican audience with standard 120-volt AC current. If
you live elsewhere, you should find out how your elec-
tricity is delivered to your computer and adjust ac-
cordingly. If after completing some of the calcula-
tions below you find you need a UPS bigger than say
a 2,000 to 3,000VA, and you’re not an electrical en-
gineer, then I would get some professional advice.

Optimizing your UPS purchase to suit your needs
and budget is not a simple process for the uninitiated.
They are usually rated in volt-amperes (VA), but the
manufacturer should also state a maximum wattage
for connected hardware. While you may be tempted
to get a grossly over-sized UPS relative to your needs,

8http://www.jetcafe.org/%7Enpc/doc/ups-faq.html

be aware that these systems typically function most
efficiently near their rated capacity. That said, an
over-sized UPS will deliver longer battery power in
the clinch of an outage, but you should really weigh
the cost/benefit of a big UPS versus the simple pur-
chase of a laptop, which will offer much longer work
time on its battery during a power outage.

For those who want a simple just-tell-me-the-
bottom-line answer for their UPS needs, American
Power Conversion (APC) has a nifty UPS selector9

that yields three product recommendations (all of
them APC, of course) listing them as: best price,
best value, and best performance. If nothing else it
provides one with a rough idea of what VA range
you need to be looking for.

Generally speaking, the VA output rating of the
UPS should exceed the load by at least 50% to 100%,
so how do you calculate your expected load? The
link to BC Hydro’s UPS Guide10 contains a six-step
worksheet using hardware wattage to help determine
a UPS for your needs. Very briefly, you simply obtain
the wattage of all devices to be connected, bearing in
mind that printers are energy hogs and should not be
operated on battery backup ever, and then compare
this to the total wattage listed by the UPS manufac-
turer. This will get you into the ballpark area of your
UPS needs.

However, the UPS VA rating is not the same as
power drain, measured in watts, from the hardware.
Some literature suggests a conservative factor of
Watts × 1.6=VA, while others list VA × 0.85 to
0.7=Watts. There is no way to accurately know
without actually measuring the draw of your hard-
ware with an ammeter. So where does that leave
the electronically challenged? As mentioned in the
JetCafe11 link, obtaining a UPS whose VA is equal
or greater than the total electric load rating of all
hardware will err on the side of caution, and be
properly conservative.

An additional purchase consideration is that the
batteries in a UPS have a limited life span, so you
must expect to either replace the unit in a few years
or plan ahead and purchase a UPS with the capability
to replace the battery packs. Contrary to what you
may read in some Belkin UPS reviews, I have discov-
ered that the batteries in most of their models can be

9http://apc.com/tools/ups_selector/index.cfm
10http://www.bchydro.com/rx_files/psbusiness/psbusin

ess23447.pdf
11http://www.jetcafe.org/%7Enpc/doc/ups-faq.html
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replaced either at source12 or that my 1200VA model
can even use upgraded 1500VA replacement battery
packs for the APC brand UPSs, though I would never
recommend anyone to do this.

Third-party reviews of UPS backup software run
the gamut, but the majority opinion from real folks
using it is that most of it isn’t that easy to use, so
don’t let it factor into your purchase decision too
much. Think about it this way: get a good UPS that
will give you plenty of time to save what you’re work-
ing on before shutting down, and never walk away
from your machine without saving. If your Mac is
running something that cannot be stopped without
loss, such as my 3D renders which must run to com-
pletion, then bite the bullet and either get a higher
end backup power solution, or just re-render when
the power is back on.

Use and Maintenance
As with any piece of equipment, read the manufac-
turer’s manual before you start plugging things into
your UPS. A typical UPS out of the box will require
several hours to a day to charge the batteries. Give
them the time for a full charge before you start using
it. Extension cords are not recommended as they un-
necessarily increase resistance, and while this sounds
like a no-brainer, never put a surge protector13 be-
tween a UPS and a computer. And again, don’t plug
a printer into the backup supply socket from a UPS
since they draw too much power.

Dust-clogged UPS air ventilation slots and
high(er) room temperatures can have an adverse
effect on battery life. Another point from my list
of personal misperceptions: the UPS’s batteries are
not like other rechargeable batteries since they do
not have a “battery memory” or experience longer
life if you discharge them regularly. In fact, they
lose capacity with each deep draw on their reserves.
And oh, one last thing: you should be aware that
there is enough juice in one of these things to kill
somebody, so don’t fool around inside it if you don’t
know what you’re doing, and if you’re reading this
then you don’t know what you’re doing.

Conclusion
Make your UPS purchase based on a conservative de-
termination of VA requirements, or a total wattage

12http://catalog.belkin.com/IWCatProductPage.process
?Merchant_Id=&Section_Id=2092&pcount=&Product_Id=2
48169

13http://www.jetcafe.org/%7Enpc/doc/ups-faq.html#02
08

calculation if have to, with more capacity thrown in
to accommodate hardware upgrades within the next
few years if it is within your current UPS budget.
Take the unit home and see if you can wake your
computer from sleep when it is on UPS battery power,
since I think this is an important issue that I have not
seen mentioned anywhere in the UPS literature. In
addition, I have not found an answer to why the UPS
shutdown settings in the Energy Saver pane of Sys-
tem Preferences in OS X are not activated when the
computer is in sleep mode. If anyone has a solution,
please let all of us know.

Copyright © 2007 Chris Dudar, PhD.
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Desktop Pictures
Little Leaf Sea
This Month’s Desktop Pictures1

These photos, from atpm reader David Kettlewell2,
are from the sunny, frosty forests of northern Sweden,
a place whose name translates as “Little Leaf Sea.”

Previous Months’ Desktop Pictures
Pictures from previous months are listed in the desk-
top pictures archives3.

Downloading All the Pictures at Once
Some browsers can download an entire set of desktop
pictures at once.

iCab Use the Download command to download “Get
all files in same path.”

OmniWeb Choose “Save Linked . Images. . .” from
the File menu.

Safari Use this Automator workflow4.

Contributing Your Own Desktop Pictures
If you have a picture, whether a small series or just
one fabulous or funny shot, feel free to send it to
editor@atpm.com and we’ll consider publishing it in
next month’s issue. Have a regular print but no scan-
ner? Don’t worry. E-mail us, and we tell you where
to send it so we can scan it for you. Note that we
cannot return the original print, so send us a copy.

Placing Desktop Pictures
Mac OS X 10.3.x and 10.4.x
Choose “System Preferences. . .” from the Apple
menu, click the “Desktop & Screen Saver” button,
then choose the Desktop tab. In the left-side menu,
select the desktop pictures folder you want to use.

You can also use the pictures with Mac OS X’s
built-in screen saver. Select the Screen Saver tab
which is also in the “Desktop & Screen Saver” Sys-
tem Preferences pane. If you put the atpm pictures
in your Pictures folder, click on the Pictures Folder

1http://www.atpm.com/13.02/little-leaf-sea/
2http://www.new-renaissance.net
3http://www.atpm.com/Back/desktop-pictures.shtml
4http://automator.us/examples-02.html

in the list of screen savers. Otherwise, click Choose
Folder to tell the screen saver which pictures to use.

Mac OS X 10.1.x and 10.2.x
Choose “System Preferences. . .” from the Apple
menu and click the Desktop button. With the pop-
up menu, select the desktop pictures folder you want
to use.

You can also use the pictures with Mac OS X’s
built-in screen saver. Choose “System Preferences. . .”
from the Apple menu. Click the Screen Saver (10.1.x)
or Screen Effects (10.2.x) button. Then click on Cus-
tom Slide Show in the list of screen savers. If you
put the atpm pictures in your Pictures folder, you’re
all set. Otherwise, click Configure to tell the screen
saver which pictures to use.

Mac OS X 10.0.x
Switch to the Finder. Choose “Preferences. . .” from
the “Finder” menu. Click on the “Select Picture. . .”
button on the right. In the Open Panel, select the
desktop picture you want to use. The panel defaults
to your ~/Library/Desktop Pictures folder. Close
the “Finder Preferences” window when you are done.
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Cortland
by Matt Johnson, mjohnson@atpm.com
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Copyright © 2007 Matt Johnson, mjohnson@atpm.com.
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Software Review
by Ellyn Ritterskamp, eritterskamp@atpm.com

Arctic Quest 1.0
Developer: Exclusive Games1

Price: $20
Requirements: 800 MHz Mac with Mac

OS X 10.3.9, 32 MB of VRAM.
Not Universal2.

Trial: Feature-limited (60 minutes, no
bonuses)

I love shape-puzzle games. I played the origi-
nal Tetris3 game for hours at a stretch on my
Macintosh Classic4 in the early 90s. Black-and-
white, tiny screen, it didn’t matter. So when any of
these kind of games come across our review list, I
ask for them.

I explored Arctic Quest site for Windows5. I
played the online version a few times and thought
it was cute. The islands are icy, and we have to
complete the puzzles to melt them. There is a Snow
King, but you don’t battle him until many levels
later, so I never met him. He has set up these chal-
lenging puzzles where you rotate objects to complete
a shape. If you use all your large pieces too soon,
you’ll have to drop the extras in the ocean. If the
ocean fills up, you lose. There is a fire on one end of
the island, so you can melt some of the extra pieces
to hold off losing. All very cute.

1http://www.exclusivegames.com
2http://www.apple.com/universal/
3http://www.tetris.com/
4http://en.wikipedia.org/wiki/Macintosh_Classic
5http://www.alawar.com/games/arctic-quest/

The artwork is very pretty.

I downloaded the game from the Alawar site, and
saw it was an .exe file, and wondered what was up.
Then I looked at my Review Editor’s information,
and realized I had gone to the wrong site. Uh-oh, I
thought. I am getting a game from someone other
than the original developer. And this turned out
to be true. The developer on the Macintosh Arc-
tic Quest game is Exclusive Games, LLC. I went to
their site and saw this message:

Exclusive Games, LLC is the game de-
velopment and publishing company. We
specialize in 3D-games development for
Windows, and recently has successfully
started porting to Mac OS X platform.

I did not mind the two grammatical errors. They
alerted me the text was written by someone for whom
English is not the first language, and I am not elitist
about this but curious about the company. Curiosity
is fine, but I am wary of programs ported from Win-
dows. They tend to have been written with Windows
in mind, and thus tend to be smell funny once they
are rewritten. Not every piece of software in the his-
tory of software has had this problem, but we all run
into programs that run smoothly and those which do
not. In my limited experience, software that began
life on Windows just doesn’t do all that well when
someone tries to rewrite it for Macs.
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So I was predisposed to find this software
mediocre. I allowed for that. I liked the draw-
ing, and I liked the music. I began the game, and
played for a level or two, and then I got bored. The
shapes were colorful and interesting, and varied with
level. But I was bored. Maybe it was too soothing.
Maybe the ice made me sleepy. Whatever the reason,
I was not fired up about it, so I thought I would
investigate the bonus material. I clicked on Register
and the game croaked. The music kept playing,
but the game went away. I thought maybe I could
register from a fresh start-up of the game, but no
matter how I tried to register (three different paths),
it killed the game. The bonuses appear to be various
critters: a snail that slows down time, etc. But I will
never know for sure; I am going by the Help screen
from Alawar’s online game.

The game is generally sluggish to load. The cur-
sor takes a few seconds too long to become functional.
Possibly my Mac does not meet the system require-
ments, though I have doubts. I am sure my Intel-
based Mac mini does meet the system requirements,
so the crashing when I try to register is not because
of anything systemic I can identify.

A download from Exclusive Games gets you 60
minutes of free trial, minus bonuses, so you have am-
ple time to decide if you want to pay $20 for this
game. I would not pay $5 for it, because I would
rather play a 22-year-old Russian game of Tetris on
a 7-inch black-and-white screen. That game had no
fire and no ice. The music was cheesy. The blocks
didn’t change with level. But it did not crash, and
it was never boring. It just played and played and
played.

Copyright © 2007 Ellyn Ritterskamp, eritterskamp@atpm.com.
Reviewing in atpm is open to anyone. If you’re interested,
write to us at reviews@atpm.com.
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Software Review
by David B. Thompson, dthompson@atpm.com

MoRU 1.3.4
Developer: Windstorm Software1

Price: $10
Requirements: Mac OS-X 10.4.

Universal2.
Trial: Fully-featured (30 days)

For those of you who follow such things, you know
I moved early in January from Texas to Nevada. (If
you didn’t know, well, you know now!) So I needed
a quick-and-dirty review for this month’s issue of
atpm. The editors run a pretty tight ship.

To continue last month’s theme, then, I still like
small, efficient programs that do one task well. I’m
also looking for ways to make the embedded compo-
nents of Tiger work for me. One of those components
is Spotlight, which has so much potential that I seem
unable to tap. That’s probably a personal lacking on
my part, but I think that if I’m not seeing the big
picture, then there’s probably at least one other per-
son who, like me, is also failing to see the full impact
of the tool.

I came across a small application this month
called MoRU (pronounced “moe rue”). It’s an
acronym for Most Recently Used. The tool is an
interface into Spotlight and offers advanced searching
of the OS X filesystem.

Installation and Use
As with most small programs, installation is straight-
forward. I downloaded the disk image, mounted
it, copied MoRU to the Applications folder, and
launched it by double-clicking its icon.

There are three entries on the Preferences list:
Search Defaults, Quick Search, and General. Search
Defaults lets you set a few things, such as the max-
imum number of hits, the search location, and some
additional settings. The defaults work pretty well
and they can be tweaked from the main window.

1http://www.windstormsoftware.com/wssw/moru/index.h
tml

2http://www.apple.com/universal/

The main program window has three panes: the
left pane contains a list of default searches plus any
new searches the user adds, the top pane offers a text-
input field and a few radio buttons to control the
search, and the bottom pane displays search results.

In the example shown above, I was searching for
a bibliographic citation, viessman, that I suspected
was in a file somewhere on my Mac. Because I ex-
pected the text to be inside a file and not a filename,
I checked the button to search content. All words
and whole words were the other two defaults, but I
left them alone.

MoRU accessed the Spotlight database and ex-
tracted every file at or below the Home directory on
my system for files that contained the word “viess-
man.” There were 119 hits (displayed on the left pane
next to the search). The entries were sorted in most-
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recently-used order, and the top entry contained the
text I was looking for. (It’s a bibliography file used by
my writing system, TeXShop.) There were a number
of other interesting hits as well, but they were not
the files I was looking for.

I could double-click on the entry and the bibli-
ography manager (BibDesk) would open the file so I
could find the entry.

MoRU comes with eleven standard searches, ar-
rayed on the left pane of the main window. For ex-
ample, I clicked on the “Applications” search. MoRU
required about fifteen seconds to populate the results
pane. (Part of that time was required to spin-up the
disk in my MacBook Pro, which was asleep.) Accord-
ing to MoRU, I have 259 applications on my system.
They are displayed in most-recently-used order. It’s
pretty easy to tell what I use most of the time on my
system! (Pay no attention to that Civ IV demo! It’s
not mine, I swear! I only do work on my Mac!)

The entries on the results pane are double-
clickable, meaning that applications can be launched
from within MoRU. Although it isn’t intended to
be a Finder replacement, the program does provide
access to applications if you want to use it that way.

One of the powerful features of MoRU is the
Smart Group. A Smart Group is a specialized
search that groups files together based on specific
attributes. In the figure below, the attributes chosen
for the iTunes Music Smart Group is a location
(/Volumes/Digital Music/Music/iTunes) and the
Any Audio type file.

I set up a search for all PDF files that contained
my last name. The Smart Group is shown below,
followed by the results.

The search found 497 PDF files with my name
inside. The most-recently used file was 0-5822-
ExhibitB.pdf, which is a technical workplan for one
of my research projects. I made that PDF this
morning to mail to a graduate student. Spotlight
indexed the file and MoRU found it for me.

Logical operators are available to extend the
searching capability of MoRU. Complex searches
with logical AND’s and OR’s are available. The
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program contains a wealth of features for finding the
files you want.

All that power comes with a learning curve. How-
ever, unlike some shareware programs, MoRU comes
with an excellent help file that contains information
useful to end users.

Conclusions
I have a lot of files on my MacBook Pro. My Docu-
ments directory contains more than 40,000 (10 GB)
files. So, finding what I’m looking for, even with a so-
phisticated filing system, can be daunting. Spotlight
helps, but returns a haystack from a larger haystack.
MoRU helps more because it allows me to refine Spot-
light searches and reduce the number of hits returned
from the Spotlight indexes.

It will be interesting to see if MoRU holds up to
the test of time. I’m going to register my copy and
we’ll see how frequently I use it. I suspect that it will
remain one of those utilities that sits in my Appli-
cations directory until I’m really searching for some-
thing I need now, and then it will save my carcass
when the pressure is on.

I think this is an excellent program, especially for
users who, like me, have many files on their systems.

Copyright © 2007 David B. Thompson, dthompson@atpm.com.
Reviewing in atpm is open to anyone. If you’re interested,
write to us at reviews@atpm.com.
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Software Review
by Eric Blair, eblair@atpm.com

NetworkLocation 1.1
Developer: Centrix.ca1

Price: $15
Requirements: Mac OS X 10.4.

Universal2.
Trial: Feature-limited (five location

changes per session).

Given the increasingly important role of notebook
computers over the last few years, it’s continually
surprised me that Mac OS X’s support for multiple
locations has paled in comparison to the classic Mac’s
Location Manager. Under OS X, a location is simply
a collection of network settings. The classic Location
Manager, on the other hand, understood that a loca-
tion was a place, not simply a network connection.

NetworkLocation, from Centrix.ca, attempts to
bring back this missing functionality with an updated
sense of style more fitting an Mac OS X application.

NetworkLocation’s main interface, called the
Chooser, appears as a floating panel in front of ev-
erything else displayed on the screen. Its appearance
is customizable, as NetworkLocation includes six
skins—five solid colors and one wood pattern. The
Chooser easily allows you to select your location from
the locations defined in the Network preference pane.
You can configure the Chooser to automatically
appear under two different circumstances—when
joining an AirPort network or when waking your
computer from sleep after a user-selectable period of
time. The ability to display the Chooser on joining
a new AirPort network appears to be limited to the
built-in AirPort card. If you use a PC Card adapter
for wireless networking (for instance, to use a newer
network card than what’s built-in to your computer),
the Chooser does not automatically appear.

The Chooser can be dismissed by selecting a lo-
cation, clicking outside the Chooser, pressing the Es-
cape key, or waiting for the Chooser to timeout.

1http://centrix.ca/NetworkLocation/
2http://www.apple.com/universal/

The NetworkLocation Chooser

Although the Chooser puts an attractive face on
changing networks, the interface is not without its
problems. If you dismiss the Chooser through any
means other than clicking outside the Chooser, Net-
workLocation remains the the frontmost application.
This issue is compounded if you’ve decided not to
show the NetworkLocation icon in the Dock. In this
situation, the menu bar will indicate that some other
application (like “Finder”) is active, but said appli-
cation will not respond to any keyboard commands.
If you don’t understand why this is happening, it can
be frustrating.

As an alternative to the Chooser, NetworkLoca-
tion also offers a menu bar item. This menu gives
you access to all your network locations, NetworkLo-
cation’s preferences, and the Chooser while also al-
lowing you to quit the application. After you change
locations, the menu can be a little slow to indicate the
currently-selected location. I assume this is because
it takes a short period of time for Mac OS X to change
locations and NetworkLocation is probably querying
the OS to determine the appropriate location.

NetworkLocation include ten built-in actions that
you can use to construct what happens when you
switch to a given location. These ten actions include
the following:

• Changing Mail’s SMTP server.
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• Changing the default printer.

• Connecting to a server via the Finder.

• Launching an application or running a script.

• Opening a URL.

• Playing an iTunes playlist.

• Quitting an application.

• Setting the display brightness.

• Setting how often Mail checks for new mail.

• Setting the system volume.

Creating a new action for a location.

Most of the actions that change settings include
the option to restore the previous setting when
switching out of the location. This option is miss-
ing from the mail check interval action, however.
Another such mismatch occurs between the launch
application and quit application actions. The launch
application action allows you to specify that an
application or script should be run when leaving a
location. The quit application action has no such
option—you are limited to only quitting applications
when entering a location.

I’ve also encountered some flakiness with the cre-
ation of action instances for locations. There’s noth-
ing that seems to adversely affect the NetworkLo-
cation’s operation, but the behavior certainly feels
wrong. When you create a launch or quit action, the
user interface allows you to save the action without
selecting any application, which doesn’t make any
sense. However, the mail check and iTunes actions
are more obviously broken—if you create the action

instance without changing the default selection (“5
minutes” for mail checking and “Library” for iTunes),
you get an action instance that appears to do nothing
when run.

Actually, my biggest issue with NetworkLocation
is the included collection of actions. The ten built
into the application are a mix of network- and place-
specific action, which is a step in the right direction.
However, I would like to see more place-specific ac-
tions in a future version of the application. For in-
stance, I wanted to create an airplane location for
when I was traveling. Those who travel know that
flying means no radio transmission from laptops—
meaning no AirPort and no Bluetooth. I tried writ-
ing an AppleScript for turning off AirPort, but even
though I’ve had a bit of experience with AppleScript-
ing, I was not successful. Somebody without Ap-
pleScript experience who just wanted their laptop to
better handle different places would most likely be
out of luck.

Other possible ideas for additional actions include
control over power management options, configura-
tion of popular non-Apple products (like Entourage
or NetNewsWire), or fun things like changing the
desktop picture or screen saver.

In its current state, NetworkLocation is a promis-
ing application. It offers much of the basic function-
ality that the users could be want for while look-
ing good, but it does not provide a particularly wide
range of options out of the box. Users comfortable
with AppleScript can widely extend the NetworkLo-
cation’s functionality, but less experienced users will
be stuck with the somewhat limited options. The
small set of base functionality and combined with
rough edges I’ve mentioned prevent me from heartily
recommending NetworkLocation to everybody, but
you should look into it if you have a laptop and find
yourself regularly moving between different locations.

Copyright © 2007 Eric Blair, eblair@atpm.com. Reviewing
in atpm is open to anyone. If you’re interested, write to us
at reviews@atpm.com.
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Accessory Review
by Frank H. Wu, frankhwu@mac.com

Python System
Developer: Booq1

Price: $270
Requirements: MacBook or MacBook

Pro
Trial: None

I remember when ballistic nylon was novel. I ordered
a briefcase made of ballistic nylon made by a little
shop in Vermont that advertised in the back of the
New Yorker magazine. The proprietors were artisans
who handmade their goods, and they even accom-
modated my special request for a set of straps that
would allow me to wear the briefcase like a backpack
so I could use it while riding a motorcycle.

Nowadays, ballistic nylon is common. The little
shop in Vermont is no longer advertising in the back
of the New Yorker magazine, and presumably it is out
of business. Regular nylon is passed off as ballistic
nylon, so even if the genuine material is still durable
it doesn’t have the same cachet anymore.

Yet there are companies that use ballistic nylon to
produce superior products. Booq is one of them. I’ve
acquired more laptop bags, cases, and sleeves than
I can count, and there are only few companies that
show the same quality as Booq. It is innovative, se-
rious in commitment to top-notch design, and boasts
very good customer service. It is a good fit, literally
and figuratively, for Apple. Tumi was once great, but
it seems to have remade itself as a company more
concerned with fashion than design, changing shapes
and colors every season. Brenthaven remains reliable,
and its backpack offerings are excellent choices if the
independent sleeve carrying option is not important
and if the simpler design is appealing.

So I’ve liked Booq products since I began using
the Vyper sleeve for a PowerBook. A search of the
Web persuaded me there didn’t seem to be anything
better than the Booq Python backpack on the mar-
ket. Like a kid studying the Sears “Wishbook” before
Christmas, I looked at the Booq Web site obsessively
before I finally decided for certain I wanted to order
the Booq Python system.

1http://booqbags.com/s.nl/it.A/id.231/.f

When it arrived, I was not disappointed. The
Python has two main compartments, plus a de-
tachable daypack with its own removable carrying
strap. The front compartment—i.e., that closest to
the wearer’s back—is thin and meant for the laptop
to slide into. It holds a Booq-brand Vyper case2,
but it has enough tolerance to accept other cases.
The middle compartment is more capacious. It has
numerous internal pockets—the profusion of pockets
distinguishes this backpack. I have never seen any
bag of any nature with more pockets. It will take
some time to figure out a system to ensure the
optimal use of these spaces. The interior is lined in
a thin nylon fabric. There also is a key clip dangling
from the top of the middle compartment.

2http://www.atpm.com/11.08/vyper.shtml
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There are two side compartments, with a zip-up
portion and a pocket. And there are two little com-
partments on the sides of the back, to the left and the
right of the detachable daypack. There is an almost
hidden pocket that is just big enough to hold a few
magazines, hidden directly on the back, with a zipper
on one side.

The construction is sturdy throughout. All the
zippers are reinforced and have dual pulls. The de-
tachable dayback and the middle compartment have
a nicely done rubber-reinforced slit to allow cables to
pass through, allowing you to have an iPod or other
device inside the backpack and run headphones or
other cords out. The middle compartment has an
additional zip-open flap at the top to allow quick ac-
cess without fully unzipping the sides. The straps are
wide and modestly padded. There is a sternum strap
and a waist strap, along with a carry handle covered
with what seems to be leather-like material.

The backpack comes in multiple configurations.
There are sizes to fit any Mac notebook. Another
option is to order it as I did, in the system config-
uration. That package includes the backpack with
the Vyper sleeve, plus the new Anaconda case for
an iPod or similarly sized device. The laptop com-
partment is meant to take a sleeve of some sort. It
might be possible to drop a naked laptop into it, but
that doesn’t seem to be the best practice on a regular
basis. I’ve been using the backpack with my old Ti-
tanium PowerBook, while my MacBook Pro is in the
shop. It works fine with a JR Hill leather sleeve over
the Titanium PowerBook, and it’d likely work fine
with any PowerBook or MacBook. The Vyper case,
incidentally, is terrific even on its own. The iPod case
attaches with Velcro on one of shoulder straps.
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There are only two issues with the Booq system,
one likely of general interest and one likely a personal
concern.

The first issue is the padding level in the laptop
carrying compartment. It may be my particular para-
noia, but I prefer slightly more padding than is built
into the bottom. (The Brenthaven sleeve system3

seems superior at least in the last iteration that I
owned.) Any problem is easily remedied, however,
by inserting a thin strip of foam at the bottom of the
area. I always save the high-quality foam that comes
with products, and it was easy enough to rummage
in the closet and find a piece to fit.

The second issue is the sheer bulk of the backpack
and its detailing (a few plastic orange tabs with the
Booq logo and a bit of orange piping). Carrying it
around, I feel as if I look like a geek headed on a polar
expedition. A person who has a job in a more for-
mal setting may find this backpack isn’t businesslike
enough. Of course, almost any backpack makes me
look like a student (for better or worse, time will cure
this.)

Perhaps the best endorsement of the Booq back-
pack is from other observers. My nephew, who also
has a couple of Apple machines of his own, looked
at it with admiration during a recent family get-
together. That is enough to demonstrate its func-
tionality and stylishness. After all, it isn’t easy to
impress a nephew.

3http://www.atpm.com/11.08/brenthaven.shtml

Copyright © 2007 Frank H. Wu, frankhwu@mac.com. Re-
viewing in atpm is open to anyone. If you’re interested,
write to us at reviews@atpm.com.
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Software Review
by Matthew Glidden, mglidden@atpm.com

SWF Movie Player 2.0
Developer: Eltima Software1

Price: $20
Requirements: 500 MHz Mac with Mac

OS X 10.2.7, 128 MB of RAM.
Universal2.

Recommended: 1 GHz G4, 512 MB of
RAM.

Trial: Feature-limited (free version3)

As a popular, low-bandwidth movie format, Adobe’s
Flash4 shows up everywhere on the Web. Typically,
sites embed Flash files as ads or navigation. Creative
types make Flash movies, games, or other interactive
entertainment. SWF Movie Player helps you play
back all of them, independent of your Web browser.

In simplest terms, the application gives you con-
trol where Web sites put restrictions. You usually
can’t save movies or shut off the ads without disabling
Flash in some fashion. File saving, an important fea-
ture of the pro version, lets you make one download
and then watch it over and over. You can frame-by-
frame through the file, zoom in, and do many other
things basic SWF players don’t.

Installation and Getting Started
It’s a simple matter to download the package and in-
stall SWF Movie Player into your Applications folder.
Open it to see the Playlist, Viewer, and Movie Con-
trol windows.

1http://mac.eltima.com/swf-player-benefits.html
2http://www.apple.com/universal/
3http://mac.eltima.com/freeflashplayer.html
4http://en.wikipedia.org/wiki/Macromedia_Flash

The control windows in action.

If you don’t already have a Flash file in mind,
just search. “Funny flash movies” should turn
up a bunch of Google hits. Established sites like
Weebl and Bob5, OddTodd6, and Homestar Runner7

are also excellent choices.

Playback Features
To view a file separately from the page, copy the
page’s URL. In SWF Movie Player, choose “Browse
URL” from the File menu. Paste the URL, choose
“Browse,” and wait a bit. The application shows the
SWF files found on your page and a preview window.

5http://www.weebls-stuff.com
6http://oddtodd.com
7http://www.homestarrunner.com
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Double-click a listed file to watch its preview.
“Save” adds it to the current playlist and asks you
where to save it. “Open” puts it in the player
window.

Weebl brings pastry back.

The playback window resembles most movie play-
ers, with a progress bar that counts frames and VCR-
style controls. Pause at any point to resize the win-
dow up to full-screen, pan around with the hand, or
zoom in on details.

Zoom works very well in Flash, as details scale
smoothly to any resolution. Slide the zoom bar on the
controls and move the pane in the right-hand preview
window.

A closer look at the pie box.

Drag along the playback bar to go frame-by-
frame. Hollywood animators often hide things in
single frames, and their Flash counterparts are no
different. Think you saw something out of the corner
of your eye? You probably did.

Frame-by-frame picks out an odd notice.

SWF Movie Player also supports interactivity,
which many people use in their Flash movies or
games. Use the mouse in the playback window to
make choices or do anything else the file offers.
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An interactive quiz from a Thugs on Film movie review.

Saving files
The player’s pro version will save any file from the
“Browse” window. This is especially useful for some-
thing with a limited Internet lifespan, like a news
broadcast.

Will SWF Movie Player save files from YouTube
and similar video sites? (YouTube uses a format re-
lated to Flash, called “FLV.”) Supposedly you can.
Check question #1 in the application’s Help and fol-
low the instructions. I say “supposedly” because my
player would save, but not play, files from YouTube.
It could be particular to my system, so your mileage
may vary.

Annoyances
At a few points during (what seemed to me) nor-
mal use, small problems popped up. In one case, the
controls window failed to redraw properly, leaving an
empty space. Sometimes the “Browse” window took
a long time to load files from a page, even compared
to previous attempts on the same page. Other than
trouble with FLV playback, the problems resolved af-
ter closing and reopening the player.

Summary
Watching Flash files away from a browser frees you
from site ads and other visual clutter. Better still, the
extra playback controls are leaps and bounds ahead of
the typical Web experience. So is SWF Movie Player
worth the registration fee? It depends significantly
on the user. If you love to catalog favorite files, have
a slow Internet connection, or otherwise want a local
storehouse of files, it serves the purpose well.

While I like the file save option, frame-by-frame
controls, and zoom window, occasional playback
problems put speed bumps in my enjoyment. I’ll
pick and choose how I use it now and look forward
to improved versions in the future.

Alternatives For SWF and FLV Download
and Playback
Some people just want Flash file download and
playback, without this application’s extra fea-
tures. For download, consider the Firefox extension
VideoDownloader8. For FLV playback, try the
Wimpy FLV Player9. Both are no-frills and free, so
they don’t have zoom, playlists, or other features of
a more complete program like SWF Movie Player.

Copyright © 2007 Matthew Glidden, mglidden@atpm.com.
Reviewing in atpm is open to anyone. If you’re interested,
write to us at reviews@atpm.com.

8http://videodownloader.net
9http://www.wimpyplayer.com/products/wimpy_standalo

ne_flv_player.html
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FAQ: Frequently Asked Questions
What Is ATPM?
About This Particular Macintosh (atpm) is, among
other things, a monthly Internet magazine or “e-
zine.” atpm was created to celebrate the personal
computing experience. For us this means the most
personal of all personal computers—the Apple Mac-
intosh. About This Particular Macintosh is intended
to be about your Macintosh, our Macintoshes, and
the creative, personal ideas and experiences of every-
one who uses a Mac. We hope that we will continue
to be faithful to our mission.

Are You Looking for New Staff Members?
atpm is looking to add more regular reviewers to our
staff. Though all positions with About This Partic-
ular Macintosh are volunteer, reviewing is a great
way to share your product knowledge and experience
with fellow members of the Macintosh community.
If you’re interested, contact atpm’s Reviews Editor,
Paul Fatula1.

How Can I Subscribe to ATPM?
Visit the subscriptions page2.

Which Format Is Best for Me?
• The Online Webzine edition is for people who

want to view atpm in their Web browser, while
connected to the Internet. It provides sharp
text, lots of navigation options, and live links
to atpm back issues and other Web pages.

• The Offline Webzine is an HTML version of
atpm that is formatted for viewing offline and
made available in a Mac OS X disk image. The
graphics, content, and navigation elements are
the same as with the Online Webzine, but you
can view it without being connected to the In-
ternet. It requires a Web browser.

• The Print PDF edition is saved in Adobe PDF
format. It has a two-column layout with smaller
text and higher-resolution graphics that are op-
timized for printing. It may be viewed online
in a browser, or downloaded and viewed in Ap-
ple’s Preview or Adobe Reader on Macintosh or

1mailto:reviews@atpm.com
2http://www.atpm.com/subscribe

Windows. PDFs may be magnified to any size
and searched with ease.

• The Screen PDF edition is also saved in
Adobe PDF format. It’s a one-column layout
with larger text that’s optimized for reading
on-screen.

How Can I Submit Cover Art?
We enjoy the opportunity to display new, original
cover art every month. We’re also very proud of the
people who have come forward to offer us cover art for
each issue. If you’re a Macintosh artist and interested
in preparing a cover for atpm, please e-mail us. The
way the process works is pretty simple. As soon as we
have a topic or theme for the upcoming issue we let
you know about it. Then, it’s up to you. We do not
pay for cover art but we are an international publica-
tion with a broad readership and we give appropriate
credit alongside your work. There’s space for an e-
mail address and a Web page URL, too. Write to
editor@atpm.com for more information.

How Can I Send a Letter to the Editor?
Got a comment about an article that you read in
atpm? Is there something you’d like us to write
about in a future issue? We’d love to hear from you.
Send your e-mail to editor@atpm.com. We often pub-
lish the e-mail that comes our way.

Do You Answer Technical Support Ques-
tions?
Of course (although we cannot promise to answer
every inquiry). E-mail our Help Department at
help@atpm.com.

How Can I Contribute to ATPM?
There are several sections of atpm to which readers
frequently contribute:

Segments: Slices from the Macintosh Life
This is one of our most successful spaces and one of
our favorite places. We think of it as kind of the
atpm “guest room.” This is where we will publish
that sentimental Macintosh story that you promised
yourself you would one day write. It’s that special
place in atpm that’s specifically designated for your
stories. We’d really like to hear from you. Several
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Segments contributors have gone on to become atpm
columnists. Send your stuff to editor@atpm.com.

Hardware and Software Reviews
atpm publishes hardware and software reviews. How-
ever, we do things in a rather unique way. Techno-
jargon can be useful to engineers but is not always a
help to most Mac users. We like reviews that inform
our readers about how a particular piece of hardware
or software will help their Macintosh lives. We want
them to know what works, how it may help them
in their work, and how enthusiastic they are about
recommending it to others. If you have a new piece
of hardware or software that you’d like to review,
contact our reviews editor at reviews@atpm.com for
more information.

Shareware Reviews
Most of us have been there; we find that special piece
of shareware that significantly improves the quality
our Macintosh life and we wonder why the entire
world hasn’t heard about it. Now here’s the chance
to tell them! Simply let us know by writing up a short
review for our shareware section. Send your reviews
to reviews@atpm.com.

Which Products Have You Reviewed?
Check our reviews index3 for the complete list.

What is Your Rating Scale?
atpm uses the following ratings (in order from best
to worst): Excellent, Very Nice, Good, Okay, Rot-
ten. Products rated Good or better are ones that we
recommend. Okay products get the job done. We
recommend avoiding Rotten products.

Will You Review My Product?
If you or your company has a product that you’d like
to see reviewed, send a copy our way. We’re always
looking for interesting pieces of software to try out.
Contact reviews@atpm.com for shipping information.
You can send press releases to news@atpm.com.

Where Can I Find Back Issues of ATPM?
Back issues4 of atpm, dating since April 1995, are
available in DOCMaker stand-alone format and as
PDF. In addition, all issues since atpm 2.05 (May
1996) are available in HTML format.

3http://www.atpm.com/reviews/
4http://www.atpm.com/Back/

What If My Question Isn’t Answered
Above?
We hope by now that you’ve found what you’re
looking for (We can’t imagine there’s something else
about atpm that you’d like to know.). But just
in case you’ve read this far (We appreciate your
tenacity.) and still haven’t found that little piece
of information about atpm that you came here to
find, please feel free to e-mail us at (You guessed it.)
editor@atpm.com.
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